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Preface

Oracle Business Intelligence Publisher (BI Publisher) is a reporting and publishing
application that enables you to extract data from multiple data sources, create layouts
for report data, and publish the report to numerous output formats. Bl Publisher also
enables you to schedule reports and deliver the reports to multiple delivery
destinations required by your business.

Audience
This document is intended for report designers and developers using Oracle Business
Intelligence Publisher to create reports, configure reports, add translations, and use
other BI Publisher report design features.
This guide describes how to create report layouts and use BI Publisher's report editor
to assemble the components of a report. See the guides that are listed in the following
table for more information about using the product for other business roles.
Role Sample Tasks Guide
Administrator Configuring Security Oracle Fusion Middleware Administrator’s
Confieuring Svstem Settings Guide for Oracle Business Intelligence
gUrmg =y & Publisher
Diagnosing and Monitoring System
Processes
Application developer or  Integrating BI Publisher into existing Oracle Fusion Middleware Developer’s Guide
integrator applications using the application for Oracle Business Intelligence Publisher
programming interfaces
Report consumer Viewing reports Oracle Fusion Middleware User’s Guide for
. . Oracle Business Intelligence Publisher
Scheduling report jobs
Managing report jobs
Data Model developer Fetching and structuring the data to use  Oracle Fusion Middleware Data Modeling
in reports Guide for Oracle Business Intelligence

Publisher

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.
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Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For
information, visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are
hearing impaired.

Related Documentation and Other Resources

See the Oracle Business Intelligence documentation library for a list of related Oracle
Business Intelligence documents.

In addition:

= Go to the Oracle Learning Library for Oracle Business Intelligence-related online
training resources.

= Go to the Product Information Center support note (Article ID 1338762.1) on My
Oracle Support at https: //support.oracle.com.

System Requirements and Certification

Refer to the system requirements and certification documentation for information
about hardware and software requirements, platforms, databases, and other
information. Both of these documents are available on Oracle Technology Network
(O1IN).

The system requirements document covers information such as hardware and
software requirements, minimum disk space and memory requirements, and required
system libraries, packages, or patches:

http://www.oracle.com/technetwork/middleware/ias/downloads/fusio
n-requirements-100147.html

The certification document covers supported installation types, platforms, operating
systems, databases, JDKs, and third-party products:

http://www.oracle.com/technetwork/middleware/ias/downloads/fusio
n-certification-100350.html

Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.
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New Features for Report Designers

This preface describes changes to Oracle Bl Publisher report designing features for
Oracle Business Intelligence Publisher 11g Release 1 (11.1.1).

This preface contains the following topics:

= New Features for Oracle Bl Publisher 11g Release 1 (11.1.1.9)
= New Features for Oracle BI Publisher 11g Release 1 (11.1.1.7)
= New Features for Oracle Bl Publisher 11g Release 1 (11.1.1.6)
= New Features for Oracle BI Publisher 11g Release 1 (11.1.1.5)
= New Features for Oracle BI Publisher 11g Release 1 (11.1.1.3)

New Features for Oracle Bl Publisher 11g Release 1 (11.1.1.9)

New features and changes in Oracle Bl Publisher 11g Release 1 (11.1.1.9) include:

Support for Microsoft Word (.docx) Output

For RTF and BI Publisher layout types you can now enable Word as an output. The
Word output type generates your report document in the docx file format. To enable
Word output for an RTF or BI Publisher layout, select Word from the Output Formats
options list in the Report Editor. See Section 2.7, "Configuring Layouts Using the List
View."

Three output processing properties have also been added to support the DOCX
output:

= Enable change tracking

= Protect document for tracked changes

s Default font

For descriptions of these properties, see Section 10.10, "DOCX Output."

New Features for Oracle Bl Publisher 11g Release 1 (11.1.1.7)

New features for report designers in Oracle BI Publisher 11g Release 1 (11.1.1.7)
include:

s Connect Directly to Oracle BIEE Subject Areas to Create Reports
»  Excel Template Builder Enhancements

= Layout Editor Enhancements
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s Enhanced Create Report Guide
= PDF to PCL Conversion for Embedding PCL Commands in RTF Templates
»s  Support for PDF 1.7 Specification

Connect Directly to Oracle BIEE Subject Areas to Create Reports

You can now create BI Publisher reports that use a direct connection to an Oracle BI
server subject area without having to build an additional data model in BI Publisher.
For more information, see Section 2.4, "Creating Reports Using a Direct Connection to
a Subject Area."

Excel Template Builder Enhancements

The Excel Template Builder now supports automatic insertion of fields and repeating
groups removing the requirement to manually assign defined names to cells. You can
also connect directly to the BI Publisher server to download sample data, create new
reports in the catalog, and upload templates from your Excel session. For more
information, see Section 6.3, "Using the Template Builder for Excel."

Layout Editor Enhancements
Enhancements added to the layout editor are:

= Time series axis formatting
= Hide axis option
= Independent axis formatting

For more information about these, see Section 3.9.4, "Using Advanced Chart Features."

Enhanced Create Report Guide

The Create Report guide is enhanced to assist report designers with the process of
creating a report from selecting the data model to configuring the report layout. For
more information, see Section 2.3, "Creating Reports."

PDF to PCL Conversion for Embedding PCL Commands in RTF Templates

BI Publisher now provides a PDF to PCL converter. Using this utility, you can embed
PCL commands in an RTF template and, after generating PDF output, the delivery
manager converts the PDF to PCL before sending it to the printer to enable support for
PCL printers. This feature is provided to support check printing. For more
information, see Section 4.25, "Embedding PCL Commands for Check Printing."

Support for PDF 1.7 Specification

In versions of BI Publisher earlier than 11.1.1.7, the PDF utilities required that all PDF
input documents be PDF version 1.4. Starting with this release users can pass PDF
documents of later versions to the BI Publisher PDF utilities. The instructions in
Chapter 7, "Creating PDF Templates" have been revised, removing this requirement.
For more information about BI Publisher's support for PDF 1.7 see Appendix F, "PDF
Version Support.”

New Features for Oracle Bl Publisher 11g Release 1 (11.1.1.6)

New features for report designers in Oracle BI Publisher 11g Release 1 (11.1.1.6)
include:

s Improved Create Report Flow
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= Enhancements to Parameter Display Options
s Support for HTML Formatting in Data
s Support for PDF/A and PDF/X Output

Improved Create Report Flow

This release streamlines the report creation process introducing a process flow to
better guide report designers. For more information, see Section 2.3, "Creating
Reports."

Enhancements to Parameter Display Options
Enhancements to parameter display options include:

= Support for radio button and check box display of values

Parameters that are defined as a menu in the data model can now be configured to
display the menu options as a list of radio buttons or check boxes. Parameters
configured to support one value support the option to display as radio buttons.
Parameters configured to support multiple values support the option to display as
check boxes.

= New options for placement of parameters in the report viewer

Previously the report viewer always displayed the parameters in a horizontal
region across the top of the viewer. In this release. the display of the parameter
region can also be configured in one of the following ways:

- Ina vertical region along the right side of the viewer
- Asadialog
- As aseparate full page
= New report viewer toolbar button to show or hide parameters

This release adds a toolbar button to the report viewer to enable users to hide or
show the parameter region. This enhancement complements the new parameter
display options. When report parameters are configured to display as a dialog or
in a separate full page, the parameter display region is dismissed when the viewer
displays the report. Use the Parameters button to redisplay the parameter region
to make new selections.

s Search added to menus

All parameter menus having more than a specified number of options provide a
Search option.

= Option to remove the Apply button

Reports can now be configured to remove the parameter Apply button. In these
reports the action of selecting a new parameter value automatically reruns the
report.

For more information about these enhancements, see Section 2.8, "Configuring
Parameter Settings for the Report."

Support for HTML Formatting in Data

You can now convert stored XHTML to XSL-FO to display the HTML formatting from
your data in your generated report. The XHTML data must be extracted wrapped in a
CDATA section. Specific syntax must also be used in the RTF template to render it. See
Section 4.24, "Rendering HTML Formatted Data in a Report" for more information.
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Support for PDF/A and PDF/X Output

PDF/ A is a variation of the PDF standard optimized for long term archival of
documents. PDF/X is a variation of the PDF standard optimized for professional
grade printing. BI Publisher now supports these two types of output. For more
information, see Appendix E, "Generating PDF/A and PDF/X Output."

New Features for Oracle Bl Publisher 11g Release 1 (11.1.1.5)

XXVi

New features in Oracle BI Publisher 11¢ Release 1 (11.1.1.5) include:
»  Excel Templates
= Excel Template Builder

= Interactive List Component for BI Publisher Layouts

Excel Templates

An Excel template is a report layout that you design in Microsoft Excel for retrieving
enterprise data in Excel. Excel templates provide a set of special features for
controlling the display of data and providing specific formatting instructions. Excel
templates support the following features:

= Define the structure for the data in Excel output

= Split hierarchical data across multiple sheets and dynamically name the sheets
»  Create sheets of data that have master-detail relationships

= Use native XSL functions in the data to manipulate it prior to rendering

= Use native Excel functionality

For more information, see Chapter 6, "Creating Excel Templates."

Excel Template Builder

BI Publisher provides a downloadable add-in to Excel that enables you to preview the
Excel template with sample data. This facilitates design by enabling you to test and
edit the template without having to upload it to the BI Publisher catalog first. The
Template Builder for Excel is installed automatically when you install the Template
Builder for Word. The tools can be downloaded from the Home page of Oracle
Business Intelligence Publisher or Oracle Business Intelligence Enterprise Edition as
follows:

Under the Get Started region, click Download BI Publisher Tools.

For more information, see Section 6.1.5, "Desktop Tools for Excel Templates."

Interactive List Component for Bl Publisher Layouts

The list component displays all values of a data element in a vertical or horizontal list.
When viewed in interactive mode, clicking an item in the list updates the results
shown in the linked components of the report. The list enables the report consumer to
quickly see results for each item in the list by clicking the list entry. For more
information see Section 3.14, "About Lists."

Redesigned Formula Dialog for Bl Publisher

The formula dialog in the BI Publisher layout editor has been redesigned for better
usability. For more information, see Section 3.15, "Setting Predefined or Custom
Formulas."



New Features for Oracle Bl Publisher 11g Release 1 (11.1.1.3)
New features in Oracle BI Publisher 11¢ Release 1 (11.1.1.3) include:
= Major User Interface Improvements
= Shared BI Presentation Catalog
= Layout Editor Design Tool
» Interactive Viewer
= Sub Templates
= Style Templates

Major User Interface Improvements

The user interface has undergone major improvements in several areas, including a
new Home page and redesigned editors and panes. These improvements are intended
to make working with Oracle BI Publisher easier and more consistent. For information
about working in the new interface, see Oracle Fusion Middleware User's Guide for Oracle
Business Intelligence Publisher.

Shared BI Presentation Catalog

For installations of BI Publisher with the Oracle BI Enterprise Edition, BI Publisher
now shares the same catalog with Oracle BI Presentation services. For information
about the improved catalog, see Oracle Fusion Middleware User’s Guide for Oracle
Business Intelligence Publisher.

Layout Editor Design Tool

This release introduces a new type of layout template and design tool. The Layout
Editor is launched from within BI Publisher and provides an intuitive WYSIWIG
drag-and-drop interface for designing report layouts. For a complete description, see
Chapter 3, "Creating BI Publisher Layout Templates."

Interactive Viewer

For reports created with the new BI Publisher layout editor, a new interactive output
type is available. The interactive viewer enables pop-up chart details, scrollable tables,
table filtering, table sorting, and propagated filtering across different components of
the report. This interactivity is achieved simply by designing the report in the layout
editor, no additional coding is necessary. For more information, see Section 3.1,
"Overview of Bl Publisher Layouts."

Sub Templates

Previously subtemplates had to be stored outside of the BI Publisher catalog and
called at runtime from the external directory. In this release RTF and XSL
subtemplates can be saved and managed as objects in the BI Publisher catalog. For
more information, see Chapter 12, "Understanding Subtemplates."

Style Templates

A style template is an RTF template that contains style information that can be applied
to RTF layouts. The style information in the style template is applied to RTF layouts at
runtime to achieve a consistent look and feel across your enterprise reports. Style
templates are saved and managed in the BI Publisher catalog. For more information,
see Chapter 11, "Creating and Implementing Style Templates."
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Zipped PDF Output

This release introduces a feature to split a large PDF output file into smaller, more
manageable files, while still maintaining the integrity of the report as one logical unit.
When PDF output splitting is enabled for a report, the report is split into multiple files
generated in one zip file. The output type is PDFZ. For easy access to the component
files, BI Publisher also generates an index file that specifies from and to elements
contained in each component PDF file. For more information, see Section A.2,
"Generating Zipped PDF Output.”



Part |

Creating Reports and Layouts

This part describes how to create reports and layouts. It includes the following
chapters:

s Chapter 1, "Introduction to Designing Reports"

»  Chapter 2, "Creating and Editing Reports"

»  Chapter 3, "Creating BI Publisher Layout Templates"

»  Chapter 4, "Creating RTF Templates"

»  Chapter 5, "Creating RTF Templates Using the Template Builder for Word"
»  Chapter 6, "Creating Excel Templates"

»  Chapter 7, "Creating PDF Templates"

»  Chapter 8, "Creating eText Templates"

»  Chapter 9, "Creating Flash Templates"

»  Chapter 10, "Setting Report Processing and Output Document Properties"
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Introduction to Designing Reports

This chapter introduces the components that comprise a BI Publisher report.

This chapter includes the following sections:

Section 1.1, "Overview for Report Designers"
Section 1.2, "About the Layout Types"

Section 1.3, "About Setting Run-Time Properties"
Section 1.4, "About Translations"

Section 1.5, "About Style Templates"

Section 1.6, "About Sub Templates"

1.1 Overview for Report Designers

A report consists of a data model, a layout, and a set of properties. Optionally, a report
may also include a style template and a set of translations. A report designers
performs the following tasks:

Design the layout for the report. The layout can be created using a variety of tools.
The output and design requirements of a particular report determine the best
layout design tool. Options include the Layout Editor, which is a Web-based
layout design tool and enables interactive output, Microsoft Word, Adobe
Acrobat, Microsoft Excel, and Adobe Flexbuilder.

Set runtime configuration properties for the report.

Design style templates to enhance a consistent look and feel of reports in your
enterprise.

Create sub templates to re-use common functionality across multiple templates.

Enable translations for a report.

1.2 About the Layout Types

BI Publisher offers several options for designing layouts for reports. The following
formats are supported. Note that the layout type determines the types of output
documents supported.

BI Publisher layout (XPT)

BI Publisher's Layout Editor is a Web-based design tool for creating layouts.
Layouts created with the Layout Editor support interactive viewing as well as the
full range of output types supported by RTF layouts.
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= Rich Text Format (RTF)

BI Publisher provides a plug-in utility for Microsoft Word that automates layout
design and enables you to connect to BI Publisher to access data and upload
templates directly from a Microsoft Word session. The RTF format also supports
advanced formatting commands providing the most flexible and powerful of the
layout options. RTF templates support a variety of output types including: Excel
(mhtml), Excel (html), Excel (*.xIsx), HTML, MHTML, PDF, PowerPoint, RTF, and
Zipped PDE.

»  Portable Document Format (PDF)

PDF templates are used primarily when you must use a predefined form as a
layout for a report (for example, a form provided by a government agency).
Because many PDF forms already contain form fields, using the PDF form as a
template simply requires mapping data elements to the fields that exist on the
form. You can also design PDF templates using Adobe Acrobat Professional. PDF
templates support only PDF output.

s Microsoft Excel (XLS)

Excel templates enable you to map data and define calculations and formatting
logic in an Excel workbook. Excel templates support Microsoft Excel (.xls) output
only.

= XSL Stylesheet

Layouts can also be defined directly in XSL formatting language. Specify whether
the layout is for Data (CSV), Data (XML), FO Formatted XML, HTML, Text, or
XML transformation.

s eText

These are specialized RTF templates used for creating text output for Electronic
Data Interchange (EDI) or Electronic Funds Transfer (EFT) transactions.

s Flash

BI Publisher's support for Flash layouts enables you to develop Adobe Flex
templates that can be applied to BI Publisher reports to generate interactive Flash
output documents.

For more information about layout types, see Chapter 2, "Creating and Editing
Reports."

1.3 About Setting Run-Time Properties

BI Publisher provides a variety of user-controlled settings that are specified using an
easily accessible Properties dialog. These include security settings for individual PDF
reports, HTML output display settings, font mapping, currency formatting, and other
output-specific settings. For more information, see Chapter 10, "Setting Report
Processing and Output Document Properties.” These settings are also configured at the
system-level, but can be customized per report.

1.4 About Translations

BI Publisher provides the ability to create an XLIFF file from RTF templates. XLIFF is
the XML Localization Interchange File Format. It is the standard format used by
localization providers. Using Bl Publisher's XLIFF generation tool you can generate the
standard translation file of an RTF template. You can then translate this file (or send to
a translation provider). Once translated, the file can be uploaded to the report
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definition under the appropriate locale setting so that at runtime the translated report
runs automatically for users who select the corresponding locale.

For more information, see Chapter 15, "Translation Support Overview and Concepts."

1.5 About Style Templates

A style template is an RTF template that contains style information that can be applied
to layout templates. The style information in the style template is applied to report
layout templates at runtime to achieve a consistent look and feel across your enterprise
reports.

For more information, see Chapter 11, "Creating and Implementing Style Templates."

1.6 About Sub Templates

A Sub Template is a piece of formatting functionality that can be defined once and
used multiple times within a single layout template or across multiple layout template
files. This piece of formatting can be in an RTF file format or an XSL file format. RTF
subtemplates are easy to design as you can use Microsoft Word native features. XSL
subtemplates can be used for complex layout and data requirements.

For more information, see Chapter 12, "Understanding Subtemplates."
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Creating and Editing Reports

This chapter describes how to create and edit BI Publisher reports.
This chapter includes the following topics:

= Section 2.1, "About Report Components"

= Section 2.2, "Creating Reports: Process Overview"

= Section 2.3, "Creating Reports"

= Section 2.4, "Creating Reports Using a Direct Connection to a Subject Area"
= Section 2.5, "Editing Reports"

= Section 2.6, "Adding Layouts to the Report Definition"

= Section 2.7, "Configuring Layouts Using the List View"

= Section 2.8, "Configuring Parameter Settings for the Report"

= Section 2.9, "Configuring Report Properties"

»  Section 2.10, "Accessing Reports via a URL"

2.1 About Report Components
A report typically consists of the following components:
= Data Model
= Layout
»s  Properties
s Translations

The first step in creating a new report is to select the source of the data for the report.
A Data Model defines data that is used by a report. A Data Model may contain
multiple data sets and it defines how data fields are structured in relation to each
other. It may also contain parameters with lists of values, bursting definitions and
other structures or properties that determine how data is provided to a report. For
information on creating a data model, see Oracle Fusion Middleware Data Modeling
Guide for Oracle Business Intelligence Publisher.

Reports that use Oracle Business Intelligence Subject Areas as the data source do not
require a separate data model. For more information, see Section 2.4, "Creating Reports
Using a Direct Connection to a Subject Area."

The next step is to design a layout for the report data. The layout defines how the data
is presented in the report. A layout consists of a template file and a set of properties for
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rendering the template file. BI Publisher supports templates created from a variety of
sources including Microsoft Word, Adobe Acrobat, Microsoft Excel, Adobe Flash, and
BI Publisher's own layout editor. A report can include multiple layouts.

Next, configure properties for the report. The report properties enable you to control
many aspects of the report generation, formatting, and display.

Optionally, add translations for the report. BI Publisher's translation support enables
you to include translations for individual layouts or for all translatable strings in the
layout, data model, and the report metadata.

This chapter describes the process of creating a report by selecting a data model,
adding a layout, and configuring properties using the report editor. For more
information about report components, see the sections that are listed in the following
table.

Table 2-1 Information on Report Components

Topic More Information

Creating a data model See the Oracle Fusion Middleware Data Modeling Guide for Oracle
Business Intelligence Publisher

Selecting a layout type "Section 1.2, "About the Layout Types™"

Creating specific layout Chapter 3, "Creating BI Publisher Layout Templates"

template types Chapter 4, "Creating RTF Templates"

Chapter 5, "Creating RTF Templates Using the Template Builder
for Word"

Chapter 6, "Creating Excel Templates"
Chapter 7, "Creating PDF Templates"

Chapter 9, "Creating Flash Templates"”
Chapter 8, "Creating eText Templates"

Translating reports Chapter 15, "Translation Support Overview and Concepts"

2.2 Creating Reports: Process Overview

The Create Report process guides you through the steps to create a basic report. After
creating the basic report, use the report editor to configure the report and create
additional layouts.

The Create Report process guides you through the following steps:

1. Launch the Create Report guide to select a data source, and create a basic report.
You can create a simple layout using the guide or add the layout later.

See Section 2.3, "Creating Reports."

2. Edit the simple report layout that you created using the Create Report guide, or
create a new layout.

See Section 2.6, "Adding Layouts to the Report Definition."
3. Configure the properties for the layout.
See Section 2.7, "Configuring Layouts Using the List View."
4. Configure parameters for the report.
See Section 2.8, "Configuring Parameter Settings for the Report."

5. Configure report properties.
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See Section 2.9, "Configuring Report Properties."

Add translations for the layouts. Complete this step if the report requires support
for multiple languages.

See Chapter 15, "Translation Support Overview and Concepts."

2.3 Creating Reports

Launch the Create Report guide in one of the following ways:

From the global header, click New and then click Report.
From the Home page, under the Create region, click Report.
On the catalog toolbar, click New and then click Report.
From the Data Model editor page, click Create Report.

2.3.1 Selecting a Data Source

Choose one of the following options to begin building your report:

Use Data Model

Select an existing data model from the catalog.

Click Next to proceed to Choosing Guide Me or Use Report Editor.
Upload Spreadsheet

Upload a Microsoft Excel file (file type.xls or .xlsx). If the uploaded spreadsheet
contains multiple sheets, select the sheet to use as the data source. You can include
data from only one sheet.

To use multiple sheets in a workbook, you first create a data model that includes
each spreadsheet as a data set, and then use that data model as the data source for
the report. For more information, see "Creating a Dataset Using a Microsoft Excel
File" in Oracle Fusion Middleware Data Modeling Guide for Oracle Business Intelligence
Publisher.

Click Next to proceed to Choosing Guide Me or Use Report Editor.
Use Subject Area

Select a subject area from the Oracle BI repository. This option enables you to
directly query the Oracle BI server and eliminates the need to create a data model
in BI Publisher. The Create Report guide limits you to one subject area, however,
you can create a report against multiple subject areas using the report editor. For
more information, see Section 2.4.3, "Creating a Report Against Multiple Subject
Areas."

Click Next to proceed to Choosing Guide Me or Use Report Editor.

2.3.2 Choosing Guide Me or Use Report Editor
Table 2-2 describes the options on the Create Report page.
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Table 2-2 Choosing Guide Me or Use Report Editor

Option Description

Guide Me This option guides you through defining the layout of your data in
common predefined report styles. Choose this option to:

»  Create a report with simple components
= Select a common report style with basic options
= Quickly view the data in preview mode

Proceed to select the report layout. For more information, see
Section 2.3.3, "Selecting the Report Layout."

Use Report Editor This option prompts you to save the report and then opens the
report editor. Choose this option to proceed to configure the report
or to create a more complex layout. For more information, see
Section 2.5, "Editing Reports."

2.3.3 Selecting the Report Layout

When you choose Guide Me, you are prompted to select the report page options. After
you select the data source for the report, select the report page options and report
layout to define how data is displayed in the report.

To select report layout:
1. Select report page options as follows:

= Select the Portrait or Landscape page option to define the report page
orientation.

= Select the Page Header option to include the date in the report page header.

= Select the Page Footer option to include the page number in the report page
footer.

2. Select one of the following report layouts:
» Table (default)
s Chart
= Pivot Table
s Chart and Table
s Chart and Pivot Table
s Two Charts and Table
3. Click Next to proceed.

2.3.4 Choosing Columns for Report Layouts

The layout that you select on the Select Layout page drives the remaining pages that
you must complete to create the report. For example, if you select the Table layout,
Create Table is the next page displayed.

After you select a layout, select the data source columns to include in the report. As
you select columns, sample data for the columns displays on the page. The selected
columns display in the order selected.

Keep the following points in mind about sample data:
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s For data models: The Create Report process uses the sample data that is saved to
the data model. If sample data is not attached to the data model, the selected
column headings display without data.

= For uploaded spreadsheets: Sample data is displayed from the selected
spreadsheet.

s For subject areas: Sample data is displayed directly from the columns in the
subject area.

2.3.4.1 Table Layout

On the Create Table page you add columns to the layout by dragging and dropping
them from the Data Source pane to the table area. The columns are displayed in a
simple tabular format and the column widths are automatically adjusted based on the
number of selected columns as shown in Figure 2-1.

To remove a column from the table, hover your mouse over the upper-right hand
corner of the column header and click Delete.

Figure 2-1 Create Table Layout

Create Report [x]

1 2 i3 4 = 5

Seleck Data  Select Layout  Create Chart  Create 2nd Chart Create Table  Save Report

Drag figlds from the Data Source to create the table, Sample data is displaved,

Data Source

B [ DATA_DS COMPANY CORGANIZATION OFFICE_DSC LMITS

& B 3 Genmind Carp Praduction Figueroa Office 170

: COMPANY
ORGAMIZATION Stockplus Inc. Inbound Foster Office 217
CFFICE_DSC Genmind Carp Production Figueroa Office 96

[abe] ERAND
LoB Genmind Corp Production Figueroa Office 411
FPROD_DSC Skockplus Inc, Inbound Foster Office 50
EE;E;IUE Tescare Lkd, Subsidiaries Eiffel Office 296
EI B G2 Skockplus Inc, International Sherman Office 337
Proi:ct Genmind Corp Production Figueroa Office 200
Market
: Sales Genmind Corp Subcontracted Copper Office 363
Total_Expenses Tescare Ltd, Franchises Mills Cfice 344
2484
[ Show Grand Tokals Row E Preview Report
Previous Text Cancel Finish

The Show Grand Totals Row option is selected by default to automatically display an
aggregated summary row for all columns. Deselect this option to remove the row from
the table.

Click Preview Report to display the report in the report viewer.

Click Next to proceed to Saving the Report.

2.3.4.2 Chart Layout

The Chart Layout page supports three types of charts. Choose the chart type by
clicking its icon: Bar, Line, or Pie. Add columns to the chart by dragging and dropping
them from the Data Source pane to the chart area as shown in Figure 2-2. You can
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specify two values each to display for the chart Value, Series, and Label.

The layout editor supports a variety of more complex charts. To add more values to
this chart or create another chart type, edit this layout in the layout editor after saving
the report. For more information on creating layout templates, see Chapter 3, "Creating
BI Publisher Layout Templates".

Figure 2-2 Create Chart Layout
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To remove a value from the chart, hover your mouse over the upper-right hand corner
of the item label and click Delete.

Click Preview Report to display the report in the report viewer.

Click Next to proceed to Saving the Report.

2.3.4.3 Chart and Table Layout

When you select the chart and table layout, you add columns to the Create Chart page
first, click Next, and then the Create Table page displays with the columns that you
previously selected for the chart. You can also add additional columns and remove
columns on this page.

Click Next to proceed to Saving the Report.

2.3.4.4 Pivot Table Layout

When you select columns for the pivot table layout, the columns display on the Create
Table page as shown in Figure 2-3.
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Figure 2-3 Create Pivot Table Layout
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The Show Row Grand Totals option is selected by default. Deselect this option to hide
the row in the table that includes the grand total for each column.

The Show Column Grand Totals option is selected by default. Deselect this option to
hide the column in the table that includes the grand total for each row.

Click Switch Rows and Columns to flip the rows and columns axes.
Click Preview Report to display the report in the report viewer.

Click Next to proceed to Saving the Report.

2.3.4.5 Chart and Pivot Table Layout

When you select the chart and pivot table layout, you add columns to the Create Chart
page first, click Next, and then the Create Table page displays with the columns that
you previously selected for the chart. You can also add additional columns and
remove columns on this page.

Click Next to proceed to Saving the Report.

2.3.4.6 Two Charts and Table Layout

When you select the two charts and table layout, you add columns to the Create Chart
page first, click Next, and then the Create 2nd Chart page displays as shown in
Figure 2-4.
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Figure 2-4 Create 2nd Chart Layout
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Once you add columns to the Create 2nd Chart page, click Next to display the Create
Table page. The Create Table page displays with the columns that you already
selected for the first chart. You can also add additional columns and remove columns

on this page.
Click Next to proceed to Saving the Report.

2.3.5 Saving the Report

To save the report layout and the columns you added, use the Save Report page as
shown in Figure 2-5.

Figure 2-5 Save Report Page

Create Report [x]

1 2 2 4 o

Create Chart  Create 2nd Chark Create Table  Save Report

Select Data  Select Layout

Congratulations. You created your report!

Would you like to view your report or go to the Layout Editor to customize it?

« i

o

View Report
Rur and view the report,

Customize Report Layout
Use the Layout Editor to customize the report,

Previous ek Cancel Finish
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Select one of the following options:

To run the report you just created, click View Report and then click Finish. The
final page prompts you to save the report. After saving, BI Publisher runs and
displays the report in the report viewer.

To customize the report layout, click Customize Report Layout and then click
Finish. The final page prompts you to save the report. After saving, the report
opens in the layout editor.

For more information about additional report options and layouts, see Section 2.5,
"Editing Reports."

2.4 Creating Reports Using a Direct Connection to a Subject Area

Subject area reports contain queries that are issued directly to the Oracle Bl server,
therefore the report does not use a Bl Publisher data model.

When you run a report that uses a subject area as a data source, the Oracle Bl server
optimizes and determines how many queries are actually issued to the database based
on the columns selected for the report.

Keep the following points in mind when creating a subject area report:

You must use the Create Report guide to create subject area reports.

No data model is created for a subject area report. BI Publisher executes the subject
area queries as defined in Oracle BI Enterprise Edition to retrieve the report data.

In the Create Report guide, you can only select one subject area for a report. To
create a report that uses multiple subject areas, first create a report against a single
subject area using the Create Report guide and then edit the report in the report
editor to add subject areas. For more information, see Section 2.4.3, "Creating a
Report Against Multiple Subject Areas."

For reports that use a subject area, BI Publisher calculates subtotals and totals
based on the data received from the BI Server, which is already summarized. As Bl
Publisher is not performing the summary calculations, certain functions that
require access to the original column data, such as count distinct and average, may
deliver different results in BI Publisher.

Hierarchical columns that are available in Oracle BI Enterprise Edition are not
available for use in subject area reports in BI Publisher.

If you require a mix of Bl server data with additional data sources such as Excel or
SQL queries, you cannot use a subject area report. You must create a data model
for the report that issues a SQL query against the Oracle Bl server to return one
data set, and then create the additional data sets within the data model. For more
information, see "Creating Data Sets" in Oracle Fusion Middleware Data Modeling
Guide for Oracle Business Intelligence Publisher.

Be aware that if you link multiple fields from unrelated subject areas in a single
report component such as a graph, table, or pivot table, the rendering of the
component may fail because the data cannot be correlated correctly.

2.4.1 Creating Subject Area Reports

To create a subject area report:

1.
2

Launch the Create Report guide.

Select a subject area. Only one subject area can be selected.
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To report against multiple subject areas, after selecting the first subject area, select
the Use Report Editor option, and click Finish to save the report. Then, use the

report editor to add the additional subject areas. For more information, see
Section 2.4.3, "Creating a Report Against Multiple Subject Areas."

Add columns to the report as shown in Figure 2-6.

Figure 2-6 Create Subject Area Report Layout
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For more information on adding columns to a report, Section 2.3.4, "Choosing

Columns for Report Layouts."

2.4.2 Adding Parameters to Subject Area Reports

Parameters are usually defined in the data model for BI Publisher reports. Reports that
run directly against a subject area do not use a data model, therefore, you must use the

report editor to set up parameter definitions for subject area reports.

If you intend to use a subject area report in an Oracle BI Enterprise Edition dashboard
and you need to use pass parameters, see "Using Prompts with Parameterized Reports" in
Oracle Fusion Middleware User’s Guide for Oracle Business Intelligence Enterprise Edition

for more information.

To add parameters to subject area reports:

1.

In report editor, click Parameters to launch the Edit Parameters dialog as shown in

Figure 2-7.
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Figure 2-7 Adding Parameters to Subject Area Reports
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2. Click Add to launch the Select a Column to Define Parameter dialog as shown in
Figure 2-8.

Figure 2-8 Selecting a Parameter Column
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3. Select a parameter column and click OK to launch the Edit Parameter dialog as
shown in Figure 2-9.

The options displayed for selection in the Edit Parameter dialog are driven by the
parameter column data type.
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Figure 2-9 Editing Parameters
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4. Enter the parameter label to be displayed in the report.

5. Select a parameter display option:

Calendar - Provides users with a field into which they can enter a specific
date, as well as a calendar pop-up to select a date. This display option is only
available for selection if the parameter has a date column type.

Choice List - Provides users with a collapsed list of all prompt values. This
display option is useful for a long list of values where you want to provide the
user with the ability to search for a specific value.

Checkboxes - Provides users with a visible list of all prompt values where a
small, selectable box displays before each value item. This display option is
suitable for a prompt that contains a smaller set of data.

Radio Buttons - Provides users with a visible list of all prompt values where a
radio button is displayed before each prompt value. This display option is
useful for short lists of values where the user is to select only one prompt
value.

Text - Provides users with a field into which they can enter a specific prompt
value. This display option cannot be used for multiple prompt values. Only
the field and the field label are displayed for this option.

6. Select the parameter operator. The default value is set to is equal to/is in.

7. Under Options, select the parameter selection options. The selection options
control which selections can be passed by the parameter and whether to constrain
the parameter selections or not. For more information, see Section 2.8,
"Configuring Parameter Settings for the Report."

8. Click OK.

2.4.3 Creating a Report Against Multiple Subject Areas

You can use the report editor to link a report to multiple subject areas.

To add multiple subject areas to a report:

1. Use the report editor to open the report. The upper left corner displays the subjects
areas already linked to the report as shown in Figure 2-10.
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Figure 2-10 EXxisting Subject Areas

ORACLE" BI Publisher Enterprise

direct 2 semantic test

Subject Areas : Sample Sales Lite , Sample Targets Lite /

2. Click Edit Subject Areas to launch the Select Subject Areas dialog as shown in

Figure 2-11.

Figure 2—-11 Selecting Subject Areas

Select Subject Areas
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D - Sample Federated

Selected
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F - Essbase Interaction

3 - Sample Essbase GL %
=

Cancel

[ |

=

Finish

3. From the Available pane, select one or more subject areas.

4. Click Add to move the subject area(s) to the Selected pane.

5. Click Finish.

2.5 Editing Reports

The report editor is shown in Figure 2-12. Navigate to the report editor through the
Create Report process flow or by clicking a report's Edit link in the catalog.
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Figure 2-12 Edit Report Page

Click View a list to

. . configure layout properties
Click to open the data model editor. .
Configure parameters and report properties.
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Add New L t
data model. <& Add New Layou

Add new layouts

Default Manager Summary . o
Edit | Properties | Delete Edit | Properties | Delete  ~#——————— Edit existing layouts

Use the report editor to:

= Add layouts

= Configure layouts

= Configure the parameters for this report

= Configure the report properties

= Update the data model associated with the report

This procedure addresses these options in the order listed.

2.6 Adding Layouts to the Report Definition

To add a new layout, from the report editor, click Add New Layout. The Add Layout
page is shown in Figure 2-13.
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Figure 2-13 Add Layout
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) @

Upload Generate

There are three options for adding a layout to a report:

»  Create Layout - Select one of the basic or shared templates to launch the Layout
Editor.

= Upload Layout - Upload a template file layout that you have designed in one of
the supported file types.

= Generate Layout - Automatically generate a simple RTF layout.

2.6.1 Adding a Layout Using the Layout Editor
To add a layout using the Layout Editor:

1. Under the Create Layout region, click one of the basic or shared templates to
launch the Layout Editor. The shared templates are preformatted layouts with
common report components already inserted.

2. Design the template. For information on using the Layout Editor, see Chapter 3,
"Creating BI Publisher Layout Templates."

3. When finished, click Save. In the Save Template dialog enter a name for this
layout and select a locale. Click Save.

4. Click Return to return to the Report Editor.

5. Configure the settings for the layout. See Section 2.7, "Configuring Layouts Using
the List View."
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2.6.2 Adding a Layout by Uploading a Template File

Uploading a template file assumes that you have followed the instructions in this
guide for creating a template file (RTF, PDEF, Excel, Flash, or eText).

To add a layout by uploading a template file:
1. Under the Upload or Generate Layout region, click the Upload icon.
2. Inthe Upload dialog, perform the following:
= Enter a Layout Name.
»  Click Browse to locate the Template File in the local file system.
n  Select the Template Type from the list.
n  Select the Template Locale from the list.
»  Click Upload.

If you are connected to BI Publisher through the Template Builder you can upload the
layout file directly from the client tool.

For more information, see Chapter 5, "Creating RTF Templates Using the Template
Builder for Word".

2.6.3 Adding a Layout by Generating a Template File

To add a layout by generating a template file:
1. Under the Upload or Generate Layout region, click the Generate icon.
2. In the Autogenerate Layout dialog, perform the following;:

= Enter a Template Name for the layout.

s Click Generate.

The autogenerate feature creates a simple table-based RTF layout that includes all the
fields in the data model.

Note: The autogenerate layout feature can only be used with data
sets for which metadata is available. Therefore this feature cannot be
used with data sets generated from stored XML files, HTTP feeds,
Web services, or migrated data templates.

2.7 Configuring Layouts Using the List View

After creating or uploading the layouts for the report, you can configure settings for
the layout from the List View. Figure 2-14 shows the List View.

Figure 2-14 The List View

Edit Properties

Create
Delete
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2.7.1 Applying a Style Template to the Layout

A style template contains style definitions that are applied to the paragraphs,
headings, tables, and headers and footers of a report. A style template is optional and
can only be applied to an RTF template file.

For more information on creating a style template, see Chapter 11, "Creating and
Implementing Style Templates."

If you want to apply a style template to this layout, then click Choose to browse for
and select the style template. To then apply the style template to an individual layout
in the list, select the Apply Style Template box for that layout in the list of properties.

2.7.2 About the Layouts Toolbar

The Layout toolbar buttons are described in Table 2-3.

Table 2-3 Layout Toolbar Buttons

Toolbar Button Description
Create Launches the add layout page to upload or create a new layout.
Edit Launches the Layout Editor for the selected layout. This button is

enabled for BI Publisher layouts (.xpt) only.

Properties Launches the Properties page to enable the upload of localized
templates and XLIFF files to associate with this layout. This button is
enabled for RTF (.rtf) and BI Publisher layouts (.xpt) only.

For more information on localizing templates, see Chapter 15,
"Translation Support Overview and Concepts."

Delete Deletes the selected layout.

2.7.3 Configuring the Layout Settings Using the List View

The List View settings enable you to configure the following settings for the layout.
The settings are described in Table 2—4.

Table 2—4 List View Settings

Setting Description

Name Place the cursor in the text box to enter a new name for the layout.

Template File Displays the name of the file that was saved to the report definition.
Click the template file name to download it.

Type Displays the template file type.

Output Formats Select the output types to be enabled for this layout. By default, all valid

output types for a layout are enabled. The layout type determines the
output types available. See Section 2.7.4, "Selecting Output Formats" for
the complete list.

Default Format Select the default output format for this layout when viewed or
scheduled.

Default Layout Select the layout that this report uses by default when viewed online or
scheduled. Only one box in this column can be checked.

Apply Style Select this box to apply the style template to this layout. Note that a
Template style template can only be applied to RTF template files. For more
information, see Section 2.7.1, "Applying a Style Template to the
Layout".
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Table 2-4 (Cont.) List View Settings

Setting Description

Active By default a layout is active. Clear this box when you want to keep the
layout as part of the report definition, but no longer make it available.
When a layout is inactive it does not display in the report viewer or the
scheduler.

View Online By default, a layout is available for report consumers who open the
report in the Report Viewer. If this layout is for scheduled reports only,
clear this box.

Locale Displays the locale selected when the layout was uploaded. This field is
not updatable.

2.7.4 Selecting Output Formats

BI Publisher supports a wide range of output formats. Different layout types support
different output types. Table 2-5 lists all possible output types. Table 2-6 lists valid
output formats for each layout type.

Table 2-5 Output Formats

Output Format

Description

Data (CSV)

Enable this option to generate comma separated value output.

Data (XML)

Enable this option to generate XML output.

Excel (mhtml)

Enable this output type to view the report in Excel when report
consumers have Microsoft Excel 2003. This option generates an
MHTML format file that can be opened in Excel 2003 or later.
This option supports embedded images, such as charts and
logos; nested tables are not supported.

Excel (html)

Enable this output type only when report consumers are
running the earlier versions of Microsoft Excel 2000 or 2002.
This option generates HTML that can be opened in Excel. It
does not support embedded images or nested tables.

Excel (*.xlsx)

Enable this option to generate the report in Excel.xlsx (Excel
XML format). If your report consumers have Excel 2007 or later
installed, this option provides the best preservation of layout
and formatting.

Note: For this output format BI Publisher does not apply any
formatting for number and date. BI Publisher saves the
formatting mask and the actual value (date or number) into the
XLSX output file. The formatting is handled by Microsoft Excel.
For example:

= If the Microsoft Windows Region and Language of the
client computer is set to English (United States), then the
numbers and dates are formatted in en-US locale in the
Excel 2007 output file.

= If the Microsoft Windows Region and Language of the
client computer is set to French (France), then the numbers
and dates in the same Excel 2007 output file are formatted
in fr-FR locale.

FO Formatted XML This option generates a XSL-FO (Extensible Stylesheet
Language Formatting Objects) file. This output type is useful for
debugging templates.

HTML Enable HTML output for reports that require browser viewing.
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Table 2-5 (Cont.) Output Formats

Output Format

Description

Interactive

This output is only available for layouts designed using BI
Publisher's Layout Editor. Interactive output enables pop-up
chart value displays, scrollable and filterable tables, and other
interactive features for a report.

MHTML

Enable Mime Hyper Text Markup Language to allow the report
consumer to save a Web page and its resources as a single
MHTML file (.mht), in which all images and linked files are
saved as a single entity. A report consumer would use this
option to send or save HTML output and retain the embedded
images and stylesheet formatting.

PDF

Portable Document Format is commonly required for reports
that require printing or sharing.

PDF/A

Use for reports that require long-term preservation or archiving.
PDF/ A is a specialized subset of the PDF standard that
prohibits elements that may interfere with the preservation of
the file as a self-contained document.

For more information see Section E.1, "Generating PDF/A
Output.”

PDF/X

Use for reports that require formatting for prepress graphics
exchange. PDF/X is a specialized subset of the PDF standard
that streamlines documents for high-quality print production
output and restricts content that does not serve the print
production, such as signatures, comments, and embedded
multimedia.

For more information see Section E.2, "Generating PDF/X
output."

PowerPoint (mhtml)

Enable this output type to generate a PowerPoint file
compatible with Microsoft PowerPoint 2003. Note that
Microsoft PowerPoint 2010 does not support this output type.
Choose PowerPoint (*.pptx) instead.

PowerPoint (*.pptx) Enable this output type to generate a Microsoft PowerPoint file
in Microsoft Office Open XML format. This output type is
supported for versions of Microsoft PowerPoint 2007 and later.

RTF Rich Text Format. Enable this output for reports that must be
opened for editing.

Text This option generates text output for eText templates. Text
output is available only for eText templates.

Word Generates Microsoft Word .docx file.

Zipped PDFs BI Publisher can generate a zip file containing the report PDF

output and index files. This option is only available for layouts
that have been designed to enable zipped PDF output. For
information on designing a report to generate zipped PDF, see
Section A.2, "Generating Zipped PDF Output.”

Note: Data (CSV) and Data (XML) output formats are available for
all layout types. However, when you select either of these formats, no
layout formatting is applied and only data is included in the output.
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Table 2-6 Valid Output Formats for Each Layout Type

Layout Type Valid Output Types

BI Publisher template Data (CSV), Data (XML), Excel (mhtml), Excel (html), FO
created using the layout | Formatted XML, HTML, Interactive, MHTML, PDF, PDF/A,
editor (XPT) PDE/X, PowerPoint (mhtml), PowerPoint (*.pptx), RTF, Word,

Zipped PDFs

RTF template (RTF)

Data (CSV), Data (XML), Excel (mhtml), Excel (html), Excel (*.xlsx),
FO Formatted XML, HTML, MHTML, PDF, PDF/A, PDE/X,
PowerPoint (mhtml), PowerPoint (*.pptx), RTF, Word, Zipped
PDFs

PDF template (PDF)

Data (CSV), Data (XML), PDF, Zipped PDFs

Excel template (XLS)

Data (CSV), Data (XML), Excel (*.xls), Excel (html)

Flash template (SWF) Data (CSV), Data (XML), Flash, MHTML, PDF
XSL Stylesheet (FO) Same outputs as RTF template

(XSL)

XSL Stylesheet (HTML Data (CSV), Data (XML), HTML, Text

XML/ Text) (XSL)

eText template (RTF) Data (CSV), Data (XML), Text

Analyzer template (XPA)

(Supported for backward compatibility only.) Analyzer templates
can be uploaded from previous versions of BI Publisher. The
Online Analyzer in current versions of BI Publisher exports the
online analysis to layout editor templates (.xpt).

2.7.5 Editinga

Layout

To edit a BI Publisher layout (.xpt file type):

1.

Select the report from the list and click Edit.

To edit any other template type:

1.

Click the File name link to download the layout to a local computer for editing.

2.8 Configuring Parameter Settings for the Report

Parameters are defined in the data model. The report editor enables you to configure
the parameter settings specifically for each report that uses the data model.

To configure the parameters for this report:

1.

On the Report Editor page, click Parameters. The Parameters dialog is displayed

as shown in Figure 2-15.
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Figure 2—-15 The Parameters Dialog
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2. Customize the parameter settings for this report by making selections for the
following display options:

Parameter Location
This property controls where the parameter region is displayed in the report viewer.
The options are:

= Horizontal Region - displays the parameters horizontally across the top of the
report viewer

= Vertical Region - displays the parameters vertically along the left side of the report
viewer

= Full Page - displays the parameters on a separate page in the report viewer. After a
user enters parameter values, the page is dismissed. To change parameter values,
click the report viewer Parameters button to display the parameters page again.

= Dialog - invokes a dialog box to display the parameters. After a user enters
parameter values, the dialog is dismissed. To change parameter values, click the
report viewer Parameters button to display the dialog again.

Parameter Label Location
This property controls where the parameter labels are displayed. The options are:

= Place label on side - places the parameter label to the left side of the entry box.

= Place label on top - places parameter label on top of the entry box.

Show Apply Button
This property controls the display of the Apply button in the report viewer.

When set to True, reports with parameter options will display the Apply button in the
report viewer. When a user changes the parameter values, he must click Apply to
render the report with the new values.
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When set to False, the report viewer does not display the Apply button. Instead, when
a user enters a new parameter value, BI Publisher automatically renders the report
after the new value is selected or entered without further action from the user.

This property is also set at the server level. To always use the server setting, choose the
Default option. For information about configuring the server setting, see "Setting
Report Viewer Properties" in Oracle Fusion Middleware Administrator’s Guide for Oracle
Business Intelligence Publisher.

When deciding whether to remove the Apply button consider the ability of the
underlying data sources to quickly return data. Lists of values that are based on static
lists or very fast data sources are ideally suited to turning off the Apply button. If the
underlying data sources for the lists of values queries are slow, or if there are many
parameter values to set and refine before rendering the report, then retaining the
Apply button is recommended.

Show

This property controls whether the parameter is displayed to the user. Disable the
Show property if you do not want the user to see or change the parameter values that
are passed to the data model.

Type
This property is customizable for menu type parameters only. For menu type
parameters, the following display options are available:

s Checkbox

If the parameter allows multiple selections, (Multiple = True) this option is
available. The checkbox type displays all menu options in the parameter region of
the report. Users can make multiple selections, as shown Figure 2-16.

Figure 2-16 Menu Displayed as Checkboxes
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s Radio button

If the parameter allows only a single selection (Multiple = False), this option is
available. The radio button type displays all menu options in the parameter region
of the report. Users can make a single selection as shown in Figure 2-17.

Figure 2-17 Menu Displayed as Radio Buttons
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Tip: The checkbox and radio button options are best suited for
menus when the list of values is small. These options also display well
when the Parameter Location is the vertical region.

Multiple
This property is display only; it indicates whether multiple values may be selected for
a menu parameter.

Display Label
Use this property to edit the display labels shown for each parameter. The default
values are defined in the data model.

Default Value

Use this property to configure the default value for the parameter specifically for this
report. Choose "Default” to pass the default value defined in the data model.

Row Placement

Use this property to configure the number of rows for displaying the parameters and
in which row to place each parameter. For example, if your report has six parameters,
you can assign each parameter to a separate row, 1 - 6, with one being the top row; or,
you can assign two parameters each to rows 1, 2, 3. By default, all parameters are
assigned to row 1.

Note that when the Parameter Location property is set to Vertical Region, only one
parameter displays per row. You can use the Row Placement property to order the
rows vertically.

2.9 Configuring Report Properties

Launch the Report Properties dialog by clicking Properties in the page header.
Figure 2-18 shows the Report Properties dialog.

Figure 2-18 The Report Properties Dialog
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The Report Properties dialog has the following option sets:
= General - Set general properties for the report.
s Caching - Specify caching options for this report.

= Formatting - Set the runtime configuration properties for the report. See
Chapter 10, "Setting Report Processing and Output Document Properties” for
information on setting these properties.

= Font Mapping - Create font mappings for this report.

s Currency Format - Define currency formats for this report.

2.9.1 Setting the General Properties

Set the properties on the General tab as follows:

2.9.1.1 Description

(Optional) Enter a description to display with the report in the catalog. This text is
translatable.

2.9.1.2 Run Report Online

Disable this property if you do not want users to view this report in the online Report
Viewer. When disabled, users can Schedule the report only. For most reports you keep
this enabled. Disable it for long-running, batch, or other reports for which online
viewing is not appropriate. When this property is enabled, you can also set the
properties that are described in Table 2-7.

Table 2-7 Run Report Properties

Property Description Default

Show controls This property controls the display of the control Enabled
region of the report. The Control region consists of the
Template list, Output list, and Parameter lists. Disable
this property if you do not want users to view and
update these options.

Allow Sharing The Actions menu of the Report Viewer includes the | Enabled
Report Links option Share Report Link, which enables users to
display the URL for the current report. Disable this
property if you do not want users to see and copy the
report link.

Open Links in This property controls how links contained within a Enabled
New Window report are opened. By default links open in a new
browser window. Disable this property to open links
in the same browser window.

Asynchronous Reports run in asynchronous mode use a unique Not Enabled
Mode thread to execute the report when run in the report
viewer. This allows BI Publisher to cleanly terminate
the thread if a user cancels the report execution. Note
that there are performance implications when
enabling this property.

Auto Run When this property is enabled the report Enabled
automatically runs when the user selects the Open
link for the report. When Auto Run is disabled,
selecting the Open link for the report displays the
online viewer but does not run the report. The user
must select an output type from the View Report
menu to run the report.
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2.9.1.3 Advanced Options
Table 2-8 describes the Advanced properties.

Table 2-8 Description of Report Properties Advanced Options

Property

Description

Enable Bursting

Report is Controlled by
External Application. Users
cannot run or schedule
report from catalog, can
view history

Enterprise Scheduler Job
Package Name

Enterprise Scheduler Job
Definition Name

To enable bursting of the report output, select this box and then
select the appropriate bursting definition from the list. When a
user schedules the report, the selected bursting definition will be
enabled in the Scheduler.

The bursting definition is a component of the data model. For
more information, see "Adding Bursting Definitions" in Oracle
Fusion Middleware Data Modeling Guide for Oracle Business
Intelligence Publisher.

Enable this option when BI Publisher is integrated with another
application that controls the running of this report and you do
not want users to run and view this report directly from the
catalog. Reports run by BI Publisher are stored in the BI
Publisher history tables and users can view completed reports
from the Report Job History page.

This property applies to Oracle Fusion Applications
implementations only.

This property applies to Oracle Fusion Applications
implementations only.

2.9.2 Setting the Caching Properties

Figure 2-19 shows the Caching tab.

Figure 2-19 The Caching Tab
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[ user Can Refresh Report Data

OK Cancel

Table 2-9 describes the properties on the Caching tab.
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Table 2-9 Caching Properties

Variable Description Default
Enable Data When this property is enabled, the data generated by the | Not Enabled
Caching online submission of this report is stored in the cache.

Subsequent requests to run this report with the same
parameter selections display the report using the data
that is stored in the cache. This setting enhances
performance by using stored data to generate a report
rather than regenerating the data from the source. The
data remains in the cache according to the time limit that
is specified in the Cache Duration property. You can
control whether the cache for the report is shared by
users by setting the User Level property. When data
caching is enabled, you have the options of setting the
following properties:

Caching Duration | Enter the time limit for a report data set or document to | 30 minutes

(Minutes) remain in cache. Once the time limit has expired, the
next request for the same report generates a fresh data
set.
User Level This property stores a separate cache for each user. The Enabled

report data shown to each user comes only from the
private cache. When enabled, this property ensures that
each user can only see data that they are authorized to
view. However, user-level cache has less efficient
performance. If the report data is not user sensitive, you
can disable this property to enhance performance.

Document Enable this property to cache the report document. With | Enabled
Caching document cache enabled, when a user views the report
online, the document (data plus layout) is placed in the
cache. When any other user (unless User Level is
enabled) uses the online viewer to view the exact same
report (same layout, same output type, same parameter
selections) the document is retrieved from the cache. The
document remains in the cache according to the caching
duration specified. Note that scheduled reports do not
use document cache.

User Can Refresh | When this property is enabled, the user can choose to Not Enabled
Report Data refresh the data on demand. When the user clicks
Refresh in the report viewer, BI Publisher generates a
fresh data set for the report.

2.9.3 Setting the Formatting Properties

The Formatting properties tab enables you to set runtime properties at the report level.
These same properties can also be set at the system level, from the Administration
page. The Formatting properties tab displays both the system-level setting and the
report-level setting for each property. If different values are set at each level, the report
level takes precedence.

For a full description of each property, see Chapter 10, "Setting Report Processing and
Output Document Properties.”

2.9.4 Configuring Font Mapping

BI Publisher's font mapping feature enables you to map base fonts in RTF or PDF
templates to target fonts to be used in the published document. Font mappings can be
set at the report level or the system level. When you view the report properties Font
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Mapping tab, any system level settings are displayed. To change the settings for this
report, edit the font mappings here.

For detailed information on font mapping, see Section 10.17, "Defining Font
Mappings."

To create a font mapping;:
1. Under RTF Templates or PDF Templates, select Add Font Mapping.
2. Enter the following on the Add Font Mapping page:
= Base Font: Enter the font family to map to a new font. Example: Arial

= Select the Style: Normal or Italic (Not applicable to PDF Template font
mappings)

= Select the Weight: Normal or Bold (Not applicable to PDF Template font
mappings)

= Select the Target Font Type: Type 1 or TrueType

= Enter the Target Font.

If you selected TrueType, then you can enter a specific numbered font in the
collection. Enter the TrueType Collection (TTC) Number of the desired font.

For a list of the predefined fonts, see Section 10.17.4, "BI Publisher's Predefined
Fonts."

2.9.5 Configuring Currency Formats

The Currency Formats tab enables you to map a number format mask to a specific
currency so that reports can display multiple currencies with their own corresponding
formatting. Currency formatting is only supported for RTF and XSL-FO templates.

Currency formats can be set at the report level or the system level. When you view the
report properties Currency Formats tab, any system level settings are displayed. To
change the settings for this report, edit the currency formats here.

To apply these currency formats in an RTF template, you must use the format-currency
function. See Section 4.15.14, "Formatting Currencies" for detailed procedures.

To add a currency format:

1. Click the Add icon.

2. Enter the ISO currency code, for example: USD, JPY, EUR, GBP, INR.
3. Enter the format mask to apply for this currency.

The Format Mask must be in the Oracle number format. The Oracle number
format uses the components "9", "0", "D", and "G" to compose the format, for
example: 9G999D00

where

9 represents a displayed number only if present in data

G represents the group separator

D represents the decimal separator

0 represents an explicitly displayed number regardless of incoming data

For more information about these format mask components, see Section 4.15.6,
"Using the Oracle Format Mask."
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Figure 2-20 shows sample currency formats.

Figure 2-20 Sample Currency Formats

Report Properties (]
General | Caching * Formatting ~ Font Mapping | Currency Fnrmat\
+ &
| Currency Code Format Mask
uspD L9G999G999099
INR 9G99G99G999059
OK Cancel

2.10 Accessing Reports via a URL

This section describes how to call a BI Publisher report via a URL from another
application; for example, from a portal or from an Application Express application. It
contains the following topics:

2.10.1 Security Considerations

In the BI Publisher security model, reports are placed in folders and those folders are
then secured to a role and a role assigned to a user. For a user to successfully access the
report, you must ensure that the user is credentialed within BI Publisher to see it.
There are two options for this:

s Use the Guest folder

Reports in the Guest folder are available to all users to see and run. Use this option
if the report does not contain sensitive data. Enable the Guest folder on the
Security Configuration tab of the Security Center page. For more information, see
Enabling a Guest User in the Oracle Fusion Middleware Administrator’s Guide for
Oracle Business Intelligence Publisher.

s Use SSO

If both the calling application and BI Publisher are configured as partner
applications in an SSO server, you can call any report via a URL, and, as long as
the user has rights to see or run the report, then BI Publisher will render it without
the need for the user to log in. For more information on setting up security
options, see Configuring Single Sign-On in Oracle Fusion Middleware
Administrator’s Guide for Oracle Business Intelligence Publisher.

2.10.2 Building the URL
The basic URL for a report is:

http://<server:port>/xmlpserver/<ReportDirectory>/<ReportName>.xdo

where

server:port - is the name of the server and port number where BI Publisher is
running
xmlpserver -is a required static string (the name of the application)
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ReportDirectory - is the folder path to the report. When the report is under Shared
Folders, do not include "Shared Folders" in the path. If the report is under My Folders,
include the ~username as the first node in the path. See the examples following.
ReportName.xdo - is the name of the report with the .xdo extension. If the name
contains spaces, replace the space with a "+" character.

Examples:

The following URL launches the "North America Sales" report. The report resides in
the catalog under Shared Folders/Samples/Sales. Note that "Shared Folders" is not
included in the path.

http://example.com:7001/xmlpserver/Samples/Sales/North+America+Sales.xdo
The following URL launches the "North America Sales" report that resides in the

catalog under My Folders/Samples/Sales. Note that the user name in this case is
"weblogic", therefore the first node in the path is ~weblogic.

http://example.com:7001/xmlpserver/~weblogic/Samples/Sales/North+America+Sales.xdo

2.10.3 Specifying Parameters in the URL

The preceding examples render the complete report inside the Bl Publisher report
viewer with all the report controls. The default layout, default output format, and
default parameters are used to render the report. You can add parameters to the URL
to specify how the report renders.

When constructing the URL, note the following standard URL syntax:
? - denotes the first parameter
& - denotes each additional parameter

The following table describes more parameters you can add to the URL.

Parameter

Definition Example Usage

_Xpt

Specifies whether to render the report in the BI _xpt=0
Publisher report viewer or export the document to a

new window appropriate for the output type. For

example, if the output type specified is html, the report
document (only) will render in a browser window; if

the output type is PDF you will be prompted to save or

open the PDF document. When this parameter is not

specified, the report renders in the BI Publisher report

viewer.

Valid values are:

= 0-renders the report in the BI Publisher report
viewer

= 1- exports the document to appropriate
application window

_xdo

(Optional) Provides the path to the report. _
xdo=%2FSamples%2FSalary+Rep
ort.xdo

_xt

Specifies the layout to use. Enter the name of the _xt=Manager+Summary
layout as defined in the report definition. If an invalid
name is entered, the default layout is used.
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Parameter Definition Example Usage

_xf Specifies the output format. If no value is specified, the _xf=pdf
default output format is used. If an invalid value is
specified, or, if a value is specified that is not enabled
for the layout, the report does not render. Valid values
are:

= analyze - use for Interactive output

s rtf

s docx
s pdf
= html

= pptx - use for PowerPoint 2007
= ppt - use for PowerPoint

= xml - use for Data

= excel - use for Excel

= excel2000 - use for Excel 2000

= xslx - use for Excel 2007

] csv

report parameters  Specify name-value pairs for the parameters specific to dept=10

as named in the the report. You must use the parameter name as

data model defined in the data model.

_xmode Specifies the report viewer mode. If not specified, _xmode=1
defaults to view in the full report viewer. Valid values
are:

= 0-view in the full report viewer.

s 1-hide BI Publisher banner, hide parameters, can
change layout, other actions: export only.

= 2 -hide Bl Publisher banner. (No Header)

= 3 -hide BI Publisher banner, hide parameters (No
Parameters)

= 4 -report document only: hide BI Publisher
banner, hide parameters, hide other actions, hide
layouts. (Document Only)

Example:

http:/ /example.com:7001/xmlpserver/Samples/Salary+Report.xdo?_xpt=0&_
xdo=%2FSamples%2FSalary%20Report.xdo&_xmode=4&dept=10&_xt=Simpleé&_
xf=html

This URL runs the report "Salary Report" located under Shared Folders/Samples. Note
the following:

_xpt=0 renders the document in the report viewer
_xdo=%2FSamples%2FSalary%20Report.xdo defines the report path
_xmode=4 renders the document only

dept=10 sets the report-specific parameter "dept" to "10"

_xt=Simple uses the layout called "Simple"

_xf=html sets the output format to html
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Creating Bl Publisher Layout Templates

This chapter describes creating BI Publisher layout templates using the layout editor.

This chapter includes the following topics:

Section 3.1, "Overview of BI Publisher Layouts"
Section 3.2, "Launching the Layout Editor"
Section 3.3, "About the Layout Editor Interface"
Section 3.4, "Page Layout Tab"

Section 3.5, "Inserting Layout Components"
Section 3.6, "About Layout Grids"

Section 3.7, "About Repeating Sections"

Section 3.8, "About Data Tables"

Section 3.9, "About Charts"

Section 3.10, "About Gauge Charts"

Section 3.11, "About Pivot Tables"

Section 3.12, "About Text Items"

Section 3.13, "About Images"

Section 3.14, "About Lists"

Section 3.15, "Setting Predefined or Custom Formulas"

Section 3.16, "Saving a Layout"”

3.1 Overview of Bl Publisher Layouts

Release 11g of Oracle BI Publisher introduces a new type of layout template. The BI
Publisher Layout template enables end users to:

View Dynamic HTML output and perform lightweight interaction with their
report data from within a browser

Generate high fidelity, pixel perfect reports to PDF, RTF, Excel, PowerPoint, and
static HTML

BI Publisher Layout Templates are created using the BI Publisher Layout Editor - a
design tool that provides a WYSIWIG, drag and drop interface for creating pixel
perfect reports in PDF, RTFE, Excel, Word, PowerPoint, and HTML. It also provides
dynamic HTML output that supports lightweight interaction through a browser. This
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interactive output is featured in Figure 3-1.

Figure 3—1 Example of Interactive Output
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Notice the following features:
= Pop-up chart details - Hover cursor over chart items to display details of data.
= Group filtering - Grouped regions can be filtered by the grouping element.

= Scrollable tables - Table data can be scrolled while maintaining display of the
headers and totals.

s Table column sorting - Table data can be sorted by different columns from within
the viewer.

= Table column filtering - Table data can be filtered by values in different columns
from within the viewer.

= Automatic table totaling - Table data totals are automatically added to the layout.
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Propagated filtering - Filter other components by clicking on chart areas or by
clicking on pivot table header, column, or elements.

Collapse and expand areas of the document.

3.1.1 When to Use a Bl Publisher Layout

BI Publisher layouts are best suited for reports of simple to medium complexity that
do not require custom coding. Because the dynamic HTML view is only available for
BI Publisher layouts, BI Publisher layouts must be used when there is a requirement to
enable a report consumer to interact with the report (change sorting, apply filters, and
SO on).

3.1.2 Prerequisites, Recommendations, and Limitations

To use the layout editor, your account must be granted a role that includes the
appropriate permissions for accessing report layout tools.

You must attach sample data to the data model before you create a new layout.
For information on adding sample data to the data model, see "Testing Data
Models and Generating Sample Data" in Oracle Fusion Middleware Data Modeling
Guide for Oracle Business Intelligence Publisher.

For optimum viewing, set your display resolution to 1024 x 768 or higher.

BI Publisher can handle a large amount of data for interactive sorting and filtering
and still provide fast response. Still it is a best practice to summarize data in the
Data Model to the level of interest for the consumer for optimal performance. BI
Publisher layouts can generate static output such as PDF or RTF documents up to
50% faster than comparable RTF layouts depending on the data.

The layout editor does not support namespaces or attributes in the XML data.

3.2 Launching the Layout Editor

Launch the layout editor in one of the following ways:

Section 3.2.1, "When Creating a New Report"
Section 3.2.2, "When Editing a Report"
Section 3.2.3, "When Viewing a Report"

3.2.1 When Creating a New Report

To launch the Layout Editor when creating a new report:

1.

Selecting the data model for the new report.
The Report Editor displays the Add Layout page.

From the Create Layout region, click a predefined template to launch the Layout
Editor.

3.2.2 When Editing a Report

To launch the Layout Editor when editing a report:

1.

In the Report Editor:
From the Thumbnail view, click Add New Layout.
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or
From the List view, click the Create button on the layouts table toolbar.

2. From the Create Layout region, click a predefined template to use to launch the
Layout Editor.

3.2.3 When Viewing a Report
To launch the Layout Editor when viewing a report:
1. Click Actions and then click Edit Layout.

The layout must have been created in the layout editor.

3.2.4 Selecting a Predefined Layout

When you create a new layout, you are given the option of selecting a predefined
layout to help you get started. Figure 3-2 shows the predefined layouts offered by the
Basic and Shared Templates.

Figure 3-2 Predefined Layouts

[sotes anaiv=

Data Model  Sales Analysis Datamodel Q

Create Layout

Basic Templates
Blank Blank Header and Header and
(Portrait) (Landscape) Footer Footer
(Portrait) (Landscape)
Shared Templates
il ' I il il 1 | sl
Chart Chart and Dashboard Mobile Apple Table
Table iPhone

The Basic and Shared Templates offer common layout structures with specific
components already added. Choosing one of the predefined layouts is optional, but
can facilitate layout design. If your enterprise utilizes a common design that is not
available here, then you can add predefined layouts for your own use, or your
Administrator can add more for all users.

3.2.4.1 Adding Shared Templates for All Users

To add predefined layout files to the shared directory for all users to access:
1. Log in with Administrator privileges and navigate to the Catalog.

2. In the Shared Folders directory, open the Components folder.

3. Locate the Boilerplates report and click Edit.

4. Click Add New Layout.
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5.

6.

Design or upload the layout.

To design the layout: Click an existing boilerplate (or blank) to launch the layout
editor. Insert the components to the layout. When finished, click Save and give the
boilerplate a name. This layout is now displayed to all users in the Shared
Templates region.

To upload a layout: Click Upload to upload a predefined BI Publisher Template
(xpt file).

Save the report.

Any BI Publisher Templates (.xpt) added to this report are displayed to all users as a
Shared Template.

3.2.4.2 Adding Personal Predefined Layouts

To add predefined layouts that are available to your account user only:

1.

2
3.
4

Navigate to My Folders.

Create a new report called "Boilerplates". This report does not have a data model.
Click Add New Layout.

Design or upload the layout.

To design the layout: Click an existing boilerplate (or blank) to launch the layout
editor. Insert the components to the layout. When finished, click Save and give the
boilerplate a name.

To upload a layout: Click Upload to upload a predefined BI Publisher Template
(xpt file).

These layouts are presented in the My Templates region when you create a new
layout.

3.3 About the Layout Editor Interface

Figure 3-3 shows the Layout Editor.

Creating BI Publisher Layout Templates 3-5



About the Layout Editor Interface

Figure 3-3 The Layout Editor
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The Layout Editor interface comprises the following:
= The top of the Layout Editor contains two toolbars:

= The Static toolbar is always available and contains common commands such
as save and preview. See Section 3.3.4, "About the Static Toolbar."

s The Tabbed toolbar includes the Insert tab, the Page Layout tab, and a
dynamic tab that shows the most commonly used actions and commands for
the selected layout component. You can collapse this toolbar to make more
room to view the design area. See Section 3.3.5, "About the Tabbed Toolbar."

»  The accordion pane on the left contains the following:

»  Use the Data Source pane to select the data fields to drag to the layout
components.

s Use the Components pane to select layout components and drag them to the
design area. You can also use the Insert tab to insert components when this
pane is collapsed.

»  Use the Properties pane to modify properties for the selected layout
component.

You can expand and display each control by clicking the title of the control or the
plus sign next to the title of the control. You can collapse the entire accordion pane
to allow more room to view the layout.

»  The lower right region is the design area for building the layout.

3.3.1 About the Data Source Pane

The Data Source pane displays the structure of the data model and the data elements
that are available to insert into the layout.
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To insert a data element, select and drag it from the Data Source pane to the
component in the layout.

The data type for each field is represented by an appropriate icon: number, date, or
text.

Figure 3—4 shows the data source pane. The icon beside each element indicates the
data type.

Figure 3—-4 The Data Source Pane
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by 10B_TITLE
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The JOB_TITLE element is shown as text, the SALARY element is shown as a number,
and the HIRE_DATE element is shown as a date data type.

Note: When you enter dates in the Layout Editor (such as a data
comparison for a filter or for conditional formatting), use one of the
following XSL date or time formats: YYYY-MM-DD or
YYYY-MM-DDTHH:MM:SS.

3.3.2 About the Components Pane

The Components pane contains the layout components that you can insert into a
report. These components include charts, pivot tables, and images. To insert a
component, simply drag and drop it to the layout.

You can also use the Insert menu to add components to the layout.

Figure 3-5 shows the Components pane.
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Figure 3-5 The Components Pane
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3.3.3 About the Properties Pane

The Properties pane displays the properties for the selected component. The properties
displayed are determined by the selected component. Some of the properties available
in the Properties pane are also editable in the dynamic tab for the component.

Click a property value to edit it. The change is applied to the component when you
move the cursor out of the field. Collapse or expand a property group by clicking the
plus or minus signs beside the group name.

The properties available for each component are discussed in detail in the
corresponding section for that component in this chapter. If a property field is blank,
then the default is used.

Figure 3-6 shows a sample Properties pane for a table column header.

Figure 3—-6 Sample Properties Pane for a Table Column Header
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3.3.4 About the Static Toolbar

The Static toolbar extends on either side of the tabbed toolbar and is shown in
Figure 3-7.

Figure 3-7 The Static Toolbar
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Use it to perform the following functions:

Undo and redo operations.
Cut, copy and paste items.

Preview as Interactive, HTML, PDF, Microsoft Word (RTF), Microsoft Excel,
Microsoft PowerPoint, or Microsoft PowerPoint 2007.

Return to the previous page.
Create a new layout.

Open a layout.

Save the layout.

Save the layout as a new copy under a different name.

3.3.5 About the Tabbed Toolbar
The Tabbed toolbar contains the following tabs:

The Insert tab provides the components and page elements that can be placed on a
layout. See Section 3.5, "Inserting Layout Components."

The Page Layout tab provides common page-level tools and commands. See
Section 3.4, "Page Layout Tab."

The component-specific tab provides the most commonly used commands and
properties for the component that is selected in the layout. For example, when you
select a chart, the Chart tab displays. See the section on a specific component for
details on the commands.

To set or control more properties for the selected component, open the Properties
pane in the accordion pane, as described in Section 3.3.3, "About the Properties
Pane"

3.3.5.1 Selecting and Deleting Layout Objects

Each of the component-specific tabs include the Select region.

The Select tool enables you to control precisely which component on the layout
has focus. This ability is particularly helpful when working with a complex layout
where components overlap. For example, to select a table, it is sometimes difficult
to click the correct spot to select the table and not a column, or header cell. To
avoid unnecessary clicking, use the Select tool to precisely select the Table
component from the list.

Figure 3-8 shows the Select tool.
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Figure 3-8 The Select Tool
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s The Delete tool provides a similar function to the Select tool to enable you to
precisely select the component to delete.

3.3.5.2 About the Insert Tab

Use the Insert tab to insert report components and page elements. Figure 3-9 shows
the Insert tab.

Figure 3-9 The Insert Tab
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The Components group displays the report components that you can insert into the
layout. To insert a component, select and drag the item to the desired location in the
design area. For more information about each component, see its corresponding
section in this chapter.

The Page Elements group contains page-level elements for the report. To insert a page
break, the page number, or the total page number calculation, select and drag the
component to the desired position in the layout.

Note: Page elements are intended for paginated output types, such
as PDF and RTF. Using them in interactive or HTML output may have
unexpected results.

3.4 Page Layout Tab

Figure 3-10 shows the Page Layout tab.

Figure 3—-10 The Page Layout Tab
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The Page Layout tab contains commands to set up the layout.
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3.4.1 Paper Options

Table 3-1 describes paper options.

Table 3-1 Paper Options

Option

Description

Orientation

Choose Portrait or Landscape.

Paper Size

Select from the following paper size options: Letter, Legal, A4, A3,
Executive, B5, Com-10, Monarch DL, or C5. The paper size
determines the dimensions of the layout area.

3.4.2 Header/Footer Options

Table 3-2 describes header and footer options.

Table 3-2 Header and Footer Options

Option

Description

Page Header

Click to insert a page header in the layout. By default, the page header
appears on every page of a printed report, but can be configured to
skip the first page. To remove the page header, click Page Header
again.

Page Footer

Click to insert a page footer in the layout. By default, the page footer
appears on every page of a printed report, but can be configured to
skip the last page. To remove the page footer, click Page Footer again.

Report Header

Click to insert a report header to the layout. The report header appears
only once at the beginning of the report. To remove the report header,
click Report Header again.

Report Footer

Click to insert a report footer to the layout. The report footer appears
only once at the end of the report. To remove the report footer, click
Report Footer again.

3.4.2.1 Setting Properties for Headers and Footers

The Properties pane enables you to set the following properties for headers and
footers. To access the Properties pane, select the header or footer in the design region,
then click Properties from the accordion pane on the left of the page.

For all report and page headers and footers:

= Height - Set the height of the header region in pixels, points, centimeters, or inches

For headers:

= Show in the first page - Select True to show the header in the first page. Select
False to suppress the header from the first page.

Figure 3-11 shows the Properties for a report header.
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Figure 3—-11 The Properties for a Report Header

Employee Salary Report : Departments Home | §
+ Data Source ) ¥ E B A4 | Insert | Page Layout
+| Components Paper HeaderFooter
-1 Properties
["] Page Header | (] Repar
El Appearance Letter i :
Height 0.50inch Portrait | Landscape Q Page Footer [ JRepor
B Misc
1 2 3
Show in the first page True PR T U YTy T T T MR B UY
True @
False
Last Name Manager Annual_Salary
Kachhar Steven King 204,000.00
De Haan Steven King 204,000.00
Hunold Lex De Haan 108,000.00
Ernst Alexander Hunold 72,000.00

For footers:

= Show in the last page - Select True to show the footer in the last page. Select False
to suppress the footer from the last page.

3.4.3 View Options

Table 3-3 describes view options.

Table 3-3 View Options

Option Description

Grid Click to insert gridlines in the layout design area. The grid unit size depends
on the Display Unit selected. To remove the gridlines, click Grid again.

Ruler Click to insert a display ruler across the top of the layout design area. The
ruler units depend on the Display Unit. To remove the ruler, click Ruler
again.

3.4.4 Display Unit

Select the unit of measure to display. This unit is used for the ruler and grid view
options, as well as for any other function that displays a measurement, such as setting
border widths and sizing grid cells. Options are: inch, px (pixel), cm (centimeter), and

point (pt).

3.4.5 Interactivity: Event Configuration
The Configure Events feature enables you to configure how components of the layout
respond to events triggered by a user when viewing the report in interactive mode.
The two types of events are:

»  Filter - If you click an element in a list, chart, or pivot table, that element is used to
dynamically filter other components defined as targets in the report. The
component being clicked does not change.

= Show Selection Only - If you click an element of a list, chart, or pivot table, the
chart or pivot table (being clicked) shows the results for the selected element only.
This action does not affect other components of the report.
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3.4.5.1 Example of Filter Event Configuration

Figure 3-12 shows an example of filter event configuration. The layout contains two
charts and a table. The first chart shows salary totals by department in a pie chart. The
second chart shows salary totals by manager in a bar chart. The table displays a list of
employees and their salaries.

Figure 3—-12 Example of Filter Event Configuration

Salary Report
Salary by Deparment Salary by Manager
2, 100K
M Executive B Steven King
" W Lex De Haan
mT 1,800K B Alexander Hun...
. P Meena Kochhar
W Finance — I Mancy Greanberg
. G W Den Raphasly
WPurchasing I Matthew Weiss
Shippin 1,200K B Adam Fripp
B =hipping W Fayam Kautling
WGales Shanta Vollman
ook B Kevin Mourgos
¥ Administration John Russell
. B Karen Partners
W Marketing BOOK B slberto Errazuriz
Human W Gerald Cambrault
Beirces W3 W Eleni Zlotkey
Fublic I Michael Hartstain
Relations W Shelley Higgins
SALARY W Accounting Ok
Employee List
MName Title Manager Salary
! - v ~
Neena Kochhar Administration Vice President Steven King 204,000.00
Lex De Haan Administration Vice President Steven King 204,000.00
Alexander Hunold Programmer Lex De Haan 108,000.00
Bruce Ernst Programmer Alexander Hunold 72,000.00
David Austin Programmer Alexander Hunold 57,600.00
Vall Pataballa Programmer Alexander Hunold 57,600.00
Diana Lorentz Programmer Alexander Hunold 50,400.00

In this report, if a user clicks on a value in the Salary by Department chart, you want
the Salary by Manager chart and the Employees table to automatically filter to show
only the managers and employees in the selected department.

Figure 3-13 shows the automatic filtering that occurs when a user clicks the Sales
department section of the Salary by Department pie chart. The Salary by Manager
chart automatically filters to display only the managers belonging to the sales
department. The Employee table automatically filters to display only the employees in
the sales department.

Creating Bl Publisher Layout Templates 3-13



Page Layout Tab

Figure 3—-13 Example of Automatic Filtering

Salary Report
Salary by Deparment Salary by Manager
[]sales
—— BOOK
xecutive
3.074%
5 7
nogaze TP _st4gn m ook
=it 4361% . =
2;3; % 78130 W Finance BO0K B 5 iﬁ;&n
----- Purchasin John
37. u 9 500K .Russell
Shippin Karen
E PRINg T .Partners
Sales Alberto
- u Errazuriz
Administration Gerald
461 . SOCE Cambrault
o ZAL W Marketing "] Eleni
’ 200K Zlotkey
™ Human
Resources
- Public 100K
" Relations
SALARY M ~ccounting 0K -
LARY SALARY
Employee List
Mame Title Manager Salary
v v ~
John Russell Sales Manager Steven King 168,000.00
Karen Partners Sales Manager Steven King 162,000.00
Alberto Errazuriz Sales Manager Steven King 144,000.00
Gerald Cambrault Sales Manager Steven King 132,000.00
Eleni Zlotkey Sales Manager Steven King 126,000.00
Peter Tucker Sales Representative John Russell 120,000.00
David Bernstein Sales Representative John Russell 114,000.00

3.4.5.2 Configuring Automatic Filtering

To configure automatic filtering:

1. On the Page Layout tab, click Event Configuration to display the Configure

Events dialog.

Figure 3-14 shows the Configure Events dialog.

Figure 3-14 The Configure Events Dialog

Configure Events

Components
Chart 1
Chart 2 %

Events
Filter
[ show Selection Only

Targets
Chart 1
¥ chart 2
[ Table 3

OK Cancel

2. In the Components column, click the layout component (lists, charts, and pivot
tables are available to configure).

3. Select Filter to enable automatic filtering in other report components.
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4. Select the report components in the Targets column to enable the automatic
filtering based on interactive events in the selected component. To disable the
automatic filtering for a target component, clear the box.

The preceding figure shows that the Filter event is enabled for Chart 1 in the
layout. Chart 2 and Table 3 are selected as targets to enable automatic filtering

when a selection event occurs in Chart 1.

The Show Selection Only option is not enabled for Chart 1. That means that Chart
1 continues to display all values when one its elements is selected.

3.4.5.3 Example: Show Selection Only

The Show Selection Only event displays only the value of the selected element within
the chart or pivot table (being acted on).

In the example in Figure 3-15, Chart 2 is configured with Show Selection Only
enabled and Filter enabled with Table 3 as the Target.

Figure 3-15 Example of Show Selection Only

Configure Events

Components
Chart 1
Chart 2

Help

Events

[¥] Fitrer
Show Selection Only

Chart 2
[ Table 3

Ok

Cancel

This configuration results in the output shown in Figure 3-16. When the user clicks on
Chart 2, only the selected value is shown in Chart 2. Because the Filter event is enabled
for Table 3, the selection is applied as a filter to Table 3.
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Figure 3-16 Example of Output from the Show Selection Only Configuration

Salary Report
Salary by Deparment Salary by Manager
[¥]5teven King
—— 2,100K
xecutive
3.074%
L 5.148% T 1,800
' - 4.361% .
W Finance
1,500K - -
WFurchasing Series: Steven King
Group: SALARY
B Shipping 1,200K Value: 1,865K
Steven
W sales King
L S00K
¥ Administration
B Marketing BO0K
Human
‘Resources 300K
Public
Relations
SALARY M Accounting 0K
! SALARY
Employee List
Mame Title Manager Salary
~ ~ v ~
Neena Kochhar Administration Vice President Steven King 204,000.00
Lex De Haan Administration Vice President Steven King 204,000.00

3.4.6 Setting Page Margins

To set the page margins for the report:
1. Click anywhere in the design area outside of an inserted component.

2. Click the Properties pane in the lower left of the Layout Editor. Figure 3-17 shows
the Properties for the page.

Figure 3—-17 The Properties for the Page

Employee Salary Report : Departments

[ Data Source B E R EE v Insert | Pagi
Components Paper
 roperen (W & O
ppearance
Margin 0.50inch 0.50inch 0. 50 Portrait | Landscape Q Page F
O Interactivity q =
Max. Connections Auto e
E Misc
Display Unit inch Q
Page Height 11.00inch
Page Width 8,50inch
i
Last Mame Manager A
Kochhar Steven King
De Haan Steven King

3. Click the value shown for Margin to launch the Margin dialog.
Figure 3-18 shows the Margin dialog.
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Figure 3—-18 The Margin Dialog

Margin

[ use same value for all sides

Top: [0.50 [ inch v

I Margin

Left: 0.50 [ inch v

I Padding
T Border

Right: [0.50 |5 inch

Bottom: |0.50 %] inch w

OK Cancel

4. Select the desired size for the margin. Enter the value for the Top, Left, Right, and

Bottom margins.

To automatically set the same value for all sides, select the box: Use same value
for all sides. This action disables all but the Top margin entry. Enter the value in

the Top to apply to all sides.

3.4.7 Setting Maximum Connections for an Interactive Report

You can limit the connections from the browser to the server for the interactive viewer.
More connections are faster but increase server load. The default is six connections.

Reduce the number to reduce the load on the server for large reports.

To set the maximum connections for this layout:

1. Click anywhere in the design area outside of an inserted component.

2. Click the Properties pane in the lower left of the Layout Editor. Figure 3-19 shows

the Properties for the page.

Figure 3—19 The Properties for the Page

Employee Salary Report : Departments
Data Source

W e ¥ EDE - Insert | Pag:

Components Paper
=l Properties |
Page k
E Appearance D D Letter v L]Pas
Margin 0.50inch 0.50inch 0. 50 Portrait | Landscape Q Page F
B Interactivity q 3 _

Max. Connections Auto L

B Misc
Display Unit inch
Page Height 11.00inch
Page Width 8.50inch

Last Mame Manager A
Kochhar Steven King
De Haan Steven King

3. (lick the value shown for Max. Connections and select the desired value from the

list, as shown in Figure 3-20.
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Figure 3-20 Example of Max. Connections

Employes Salary Report :Departments _

[l Data Source ] U?, ENIE @} ~

| Components Paper

=l Properties

El Appearance D D Letter
Margin 0. 50inch 0. 50inch 0.50 Portrait | Landscape

Bl Interactivity

i
Max. Connections Auto P N T SO TN R T S R

Bl Misc Auto

Display Unit 1

Page Height 2 th

Page Width 3 ]
4
5
6 Averag
30

3.5 Inserting Layout Components

The layout editor supports components that are typically used in reports and other
business documents. The followings components are described in these sections:

= Section 3.6, "About Layout Grids"

= Section 3.7, "About Repeating Sections"
m  Section 3.8, "About Data Tables"

s Section 3.9, "About Charts"

= Section 3.10, "About Gauge Charts"

s Section 3.11, "About Pivot Tables"

m  Section 3.12, "About Text Items"

»  Section 3.13, "About Images"

s Section 3.14, "About Lists"

3.6 About Layout Grids

The layout grid provides a way to divide a layout into sections. It functions similarly
to a table in HTML or Word documents to create forms or to provide sophisticated
layouts. Use a layout grid to control the exact placement of all other components in the
layout.

To create a layout grid:
1. Select and drag the Layout Grid component to the design area.

Figure 3-21 shows the Create a Layout Grid dialog.
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Figure 3-21 Create a Layout Grid Dialog

Create a Layout Grid

Rows 2

Columns |2

OK Cancel

In the dialog, enter the number of rows and columns for the grid and click OK to
insert the grid to the design area, as shown in Figure 3-22.

Figure 3-22 Example of a Grid Inserted in the Design Area

E@ g “.’: =| ll 4 | Insert | Page Layout | Layout Grid Cell |
Select Font Alignment Insert Delete Join/Unjoin
i e = = m@ =] S -
B select - TiLustom = b 3% Delete Row Join Selected Cells

® pelete - (B8 & A

e B Delete Column

50 100 150 200 250 300 350 400 450 500 550 600 650
PO T T T T T T T T T T T A N S Y Y PO T T T T O O T T T AT T T N Y T T M N |

Note the following about a layout grid:

s The grid is created with equidistant columns, and the row size defaults to a
minimum of one row of text.

= Although Font properties are not enabled for a layout grid cell (set font properties
using the individual component properties), the background color and border
properties are enabled.

= When you insert a component to a grid cell, it automatically resizes to
accommodate the component.

= Adjust the column width and height by either positioning the mouse pointer over
the border and dragging the blue bar, or by changing the grid column properties
in the Properties pane.

s The grid supports merging of cells.
= You can insert a grid inside a grid.

= Similar to Microsoft Word, the grid uses a flow layout that is very convenient for
designing business documents. Components that do not occupy a full paragraph
or block are positioned top-down and left to right.

3.6.1 Adding a Border or Background Color

By default, the gridlines are displayed in the design area only and are not shown
during runtime. If you want to display the gridlines in the finished report, then select
the grid cell and click the Set Border command button to launch the Border dialog.
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To add a background color to a cell:

1. Click the Background Color command button to launch the Color Picker.

3.6.2 About the Insert Options

When you have inserted a layout grid, you can add additional rows or columns. Select
the layout grid cell that is the focal point, then click the appropriate command button:

= AddaRow above

= Add a Column to the right
s Add a Row below

s Add a Column to the left

3.6.3 About the Join and Unjoin Options

To join cells horizontally or vertically:

1. Select multiple adjacent cells by holding down the Ctrl key and clicking each grid
cell.

2. Click the Join command button.
To unjoin cells that have been joined:

1. Select the joined cell and click the Unjoin button.

3.6.4 Adding an Expand and Collapse Option

When viewing a report in interactive mode, expand and collapse of a layout grid are
supported. Expand and Collapse are supported at the grid level, (not the cell-level)
therefore ensure to insert grids appropriately. For example, if the report contains a
chart in the top portion of the layout and a table in the bottom and you want to be able
to collapse the chart display, you must insert one layout grid to contain the chart and a
second layout grid beneath the first to contain the table. Do not insert one grid with
two rows.

To enable the expand and collapse option:
1. Select the layout grid.
2. Open the Properties pane.

3. Set the Interactive: Expand/Collapse property to True. Figure 3-23 shows this
option on the Properties pane.
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Figure 3-23 The Interactive: Expand/Collapse Property

Employee Salary Report: Departments QN

[+ Data Source g 2| B3| - W
[+ Components Select
=l Properties
Bl Appearance h Select -
Border Bottom % Delete -
Border Left
Border Right oL, w0 102000 280 300
Border Top
Margin Opx Opx Op
B Misc E3
Interactive: Expand/Collapse False Last Name Manager Annual,
Kochhar Steven King
Igﬁ De Haan Steven King
Hunold Lex De Haan
Ernst Alexander Hunold
Austin Alexander Hunold
Pataballa Alexander Hunold

Figure 3-24 demonstrates the expand and collapse behavior when the report is viewed
in interactive mode. The top of the figure shows the collapse icon in the upper right
area of the report. Click the icon to collapse the grid. The bottom of the figure shows
the report with the region collapsed.

Figure 3-24 Example of the Expand and Collapse Behavior

ORACLE" BI Publisher Enterprise
O r—
Departments ey by Department

Salary Report

Salary by Deparment Sallary by Manager

-
=

ORACLE" BI Publisher Enterprise

Begpartmment| 21 - Ergloyee AL ¥ oy
Drpartments | Sy by Departeet W=D

Salary Report

Emgioryes: List

3.7 About Repeating Sections

Repeating sections repeat the components within the section of the layout based on the
occurrence of an element in the data. Repeating sections are used to create classic
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banded reports, as well as repeating pages or sections for different data elements (such
as Group Above/Outline).

To create a repeating section:
1. Drag and drop the repeating section component to the layout.
2. In the Repeating Section dialog, select one of the following:

= Element - Specify the element for which the section repeats. For example, if
the dataset contains sales information for several countries. If you select
COUNTRY as the repeat-by element, then the section of the layout repeats for
each unique country occurring in the dataset.

= Group Detail - If you have nested sections, then select this option. To continue
the previous example, assuming there are unique data rows for each city and
grouping by country, then this option creates a section that repeats for each
city.

Figure 3-25 shows a layout that has a repeating section defined for the element
Department. Within the repeating section are a chart that shows salaries by manager
and a table that shows all employee salaries. So for each occurrence of department in
the dataset, the chart and table are repeated.

Figure 3-25 An Example of a Layout that has a Repeating Section Defined for the Element Department

< 3‘% g = g | Insert | Page Layout | Return E? ) E %
Components Page Elements @
SIU IUIU LSIU ZEIIU ZSIU IUIU 3|5El 4UIU 45|U SEIIU SSIU GUIU GSIU ?UIU ?SIU
F
Salaries by Department
W Start Grouping - Department /
Department: Department
1,800k
1,500k
Rk M Steven King
W Lex De Haan
o B &lexander Hunold
1,200k B Meena Kochhar
Mancy Creenberg
. M Den Raphaely
900K Matthew Weiss =
B &dam Fripp
W Fayam Kaufling
BO0K Shanta Vollman
M Kevin Mourgos
John Russell
300K
0k
SALARY
Manager First Name Title Annual Salary
Steven King Neena Administration Vice President 204,000.00
Lex Administration Vice President 204,000.00
Den Purchasing Manager 132,000.00
Matthew Stock Manager 95,000.00
Arlam Stack Mananer 9R_40N.00

3.7.1 Setting Page Break Options for a Repeating Section

By default, for paginated output types, the page breaks automatically according to the
amount of content that fits on a page. It is frequently desirable to have the report break
after each occurrence of the repeated content.
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Using the preceding example, it is desirable for the PDF output of this report to break
after each department.

To create a break in the report after each occurrence of the repeating section:
1. Select the repeating section component.

2. Open the Properties pane.

3. Set the Page Break property to Page.

Figure 3-26 shows the Properties for a repeating section.

Figure 3-26 The Properties for a Repeating Section

| Employee Salary Report : Salary by Department Home | Catalog E MNew
'+ Data Source 7 4 IE| > | Insert | Page Layout |
[+ Components
=l Properties -
Select Filter Sart
Bl Interactivity
Interactive: Expand/Collapse True [% select ~ W Filter
Show All _
s ® oelete - Manage Filters -
Bl Misc
Mame Repeating
Page Break Auto
Auto
Page{b
E3

Department: Department

3.7.2 How Repeating Sections Display in Interactive Mode

In interactive mode, the values for the repeat by element are displayed as a list of
values. This enables the enable the report consumer to dynamically select and view the
results.

Figure 3-27 shows the repeat by element Department displayed in a list of values.

Creating Bl Publisher Layout Templates 3-23



About Repeating Sections

Figure 3-27 The Repeat by Element Department Displayed in a List of Values

Salary by Department @' V -“=-|®
A
Salaries by Department
Department
Department: Sales k
200K
700K =
BOOK W Steven King
John
500K B szl
Karen
u Fartners
400K g hlberto.
Errazuriz
Gerald
2Ll Cambrault
Eleni
200K B Zlotkey
100K
0K
Manager First Name Tite Annual Salary
v v !
Steven King John Sales Manager 168,000.00
Karen Sales Manager 162,000.00
Alberto Sales Manager 144,000.00
Gerald Sales Manager 132,000.00
Eleni Sales Manager 126,000.00

By contrast, Figure 3-28 shows the same layout displayed in PDEF. In this example the

page break option is set so that each new department begins the repeating section on a
new page.

Figure 3-28 Repeat by Element Department Layout Displayed in PDF
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3.7.3 Showing All Values in a Repeating Section

In interactive mode, the values for the repeat by element are displayed as a list of
values. By default, this list includes only the values present for the element in the data.
Therefore, a report consumer can view results for only one item at a time.

To enable a report consumer to view the results in the repeating section for all values
of the element, the Repeating Section component provides the property: Show All.
When this property is set to true, the value "All" is added to the list to enable the
display of results for all values.

To enable Show All:
1. Select the repeating section component.
2. Open the Properties pane.
3. Set the Show All property to True.
Figure 3-29 shows the Show All setting in the Properties pane.

Figure 3-29 The Show All Setting in the Properties Pane

Employee Salary Report: olary by Department U

[*] Data Source r—a }& :.J ~ Insert | |
Components Select Filter Sort
=l Properties
E Interactivity B select - ¥ Filter
Interactive: Expand/Collapse True % pelete - Manage Filters -
Show all
o True ] 100 150 200 250
B Misc P N T T T N A S R M A N T
Name True g
Page Break False
H o
4
Department: Department

When you view the report, the option All is added to the menu of values, as shown in
Figure 3-30.
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Figure 3-30 The All Option Added to the Menu of Values
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3.8 About Data Tables

The data table is a standard table that is shown in many layouts. It contains a header,
data columns, and a total row. The table supports "group left" functionality (outlines)
that merges fields with the same values as well as subtotals, grand totals, custom
calculations, and running totals.

Once inserted, you can edit the table properties using the dynamic tabs or the
Properties pane. The following dynamic tabs are available for the table components:

Table
Table Column Header
Column

Total Cell

This section contains the following topics about working with tables:

Section 3.8.1, "Inserting a Data Table"

Section 3.8.2, "Setting Alternating Row Colors"
Section 3.8.3, "About the Table Tab"

Section 3.8.4, "About the Table Column Header Tab"
Section 3.8.5, "About the Column Tab"

Section 3.8.6, "About the Total Cell Tab"

Section 3.8.7, "Inserting Dynamic Hyperlinks"

3.8.1 Inserting a Data Table

To insert a data table:

1.

From the Insert tab, select and drag the Data Table component to the design area.
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Figure 3-31 shows an inserted, empty data table. Notice that the Table tab is now

displayed.

Figure 3-31 Example of an Inserted, Empty Data Table

2.

£l Data Source
= 73 ROWSET

EB Employees

MName

| First Name
Last Name
Monthly Salary
Annual Salary
Federal_Tax_Withheld
Title
Department
Manager

Components

[ Employee Salary Report : Salary by Department

Home | Catalog

E New~ | B& Open

'“-"9 il R :j g | Insert | Page Layout | Table

and drag it to the table in the layout.

[Drop a Data Itemn Here]

Select Rows to Display Filter | Conditional Formatting | Shaow |
- (] .,
B select - | 0 - Filter 5] Highlight
X pelete - lanage Filters £ Manage Formats | | —
SIU lUIU 1.5|U ZUIU ZSIU 3UIU 350 4UIU 45|U SUIU
Salaries by L
L

To add data columns to the table, select an element from the Data Source pane

Note:

You cannot include elements from multiple data models in
report components unless the data models are linked. For more

information, see "Creating Element Level Links" in Oracle Fusion
Middleware Data Modeling Guide for Oracle Business Intelligence

Publisher.

Figure 3-32 shows the columns being added to the table. Notice that when you
drop a column on the table the sample data is immediately displayed.
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Figure 3-32 Example of Columns Added to a Table

Home
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Meena Kochhar Administration Vice President f@

Lex De Haan Administration Vice President

Alexander Hunold Programmer

Bruce Ernst Programmer

David Austin Programmer

Vali Pataballa Programmer

Diana Lorentz Programmer

Nancy Greenberg Finance Manager

Daniel Faviet Accountant

John Chen Accountant

Components
Properties <

3. Continue to drag the elements from the Data Source pane to form the columns of
the table. If you must reposition a column that you have already added, then select
it and drag it to the correct position.

Figure 3-33 shows a completed data table.

Figure 3-33 Example of a Completed Data Table
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President
Lex De Haan Administration Vice Steven King Executive 204,000.00
President
Alexander Hunold Programmer Lex De Haan T 108,000.00
Bruce Ernst Programmer Alexander Hunold | IT 72,000.00
David Austin Programmer Alexander Hunold | IT 57,600.00
Valli Pataballa Programmer Alexander Humold | IT 57,600.00
Diana Lorentz Programmer Alexander Hunold | IT 50,400.00
MNancy Greenberg Finance Manager Neena Kochhar Finance 144,000.00
Daniel Faviet Accountant Nancy Greenberg | Finance 10&,000.00
John Chen Accountant Nancy Greenberg | Finance 98,400.00
Components 3,628,800,00

Notice the following default behavior:

3-28

A total row is automatically inserted. By default it calculates the sum of the
items in the column. You can remove this row or edit the display and
calculation applied. See About the Total Cell Tab.
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s Default date formatting is applied. To change the default formatting, see
About the Column Tab.

s Default number formatting and alignment is applied. To change the default

formatting, see Section 3.8.5, "About the Column Tab."

3.8.2 Setting Alternating Row Colors

Some data tables are easier to read when the rows display alternating colors, as shown

in Figure 3-34.

Figure 3-34 Example of Rows Displayed in Alternating Colors

Last Name Title Manager Department Monthly_Salary | Annual_Salary

Kochhar Administration Vice President Steven King Executive 17000 204,000.00
De Haan Administration Vice President Steven King Executive 17000 204,000.00
Hunold Programmer Lex De Haan IT 9000 108,000.00
Emst Programmer Alexander Hunold | 1T 6000 T2,000.00
Austin Programmer Alexander Hunold | IT 4800 57,600.00
Pataballa Programmer Alexander Hunold | 1T 4800 57,600.00
Lorentz Programmer Alexander Hunold | IT 4200 50,400.00
Greenberg Finance Manager Meena Kochhar Finance 12000 144 000.00
Faviet Accountant Mancy Greenberg Finance G000 108,000.00
Chen Accountant Nancy Greenberg | Finance 8200 938,400.00
Qrimrea A rrmnintant Rlaneus Craankhorn Cinanen FTNN 07 Ann NN

To set an alternating row color:

1. Select the table.

2. Open the Properties pane.

3. Click the value shown for Alternate Row Color to launch the color picker.
Figure 3-35 shows the Alternate Row Color option.

Figure 3-35 The Alternate Row Color Option

4. Choose a color and click OK.

Employee Slary Report: Departments QR
[ Data Source =5 I ™ A = s R W
[#| Components Select Fows to Display I.=i|her | Conditic
= Properties
El Appearance k Select - | Custom - W Filter %Hig
Margin Opx Opx 12px 0pX & | 3 pelete - Manage Filters | 022 Mz
El Misc
Alternate Row Color @ S B o S S i
Name Table 1
Preview Row Count 25
Summary kd
Last Name Title
Kochhar Administration Vice President
De Haan Administration Vice President
Hunold Programmer
Ernst Programmer
Austin Programmer
Pataballa Proarammer
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3.8.3 About the Table Tab

The Table Tab enables you to perform the following:

= Set the number of rows displayed

s Define filters for the data displayed in the table

= Define conditions and formats to apply to rows that meet the conditions
= Show or hide the total row for the table

Figure 3-36 shows the Table tab.

Figure 3-36 The Table Tab

Insert | Page Layout | Table |
Select Rows to Display Filter Conditional Formatting Show
fp select- | [3p .| | Writer BRrighight T -
3¢ Delete - ? Manage Filters @Manage Formats o

3.8.3.1 Setting the Rows to Display Option

The Rows to Display property controls the number of rows of data displayed as
follows:

= When designing the layout, this property sets the number of rows that are
displayed for the table within the layout editor.

= When viewing this layout in the report viewer in interactive mode, this property
sets the size of the scrollable region for the table.

The default is 10 rows of data. You can select 10, 20, 30, 40, or All rows of data to be
displayed. To set a custom value, open the Properties pane and enter the custom value
for the Rows to Display property.

Note: Displaying more rows of data can impact the performance of
the Layout Editor.

3.8.3.2 About Filters

A filter refines the displayed items by a condition. This is a powerful feature that
enables you to display only desired elements in the table without having to perform
additional coding. For example, you could add a filter to meet some of the following
report conditions:

= Display only the top 10 salaries
= Display only the bottom 25 store sales
= Display only employees in the IT department

= Display only sales that are between $10,000 and $20,000 and in the Southern
region

You can add multiple filters and manage the order in which they are applied to the
table data.

3.8.3.3 Setting Filters for a Table

To set a filter:
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1. Click the Filter toolbar button. This launches the Filter dialog, as shown in
Figure 3-37.

Figure 3-37 The Filter Dialog

Filter (%]

Data Field |  DEPARTMENT MAME

Operator | is equal to v

Value @ |7 [ 2]

CK Cancel

2. Enter the fields to define a filter, as described in Table 3—4.

Table 3—-4 Fields to Define Filters

Field Description

Data Field Select the data field to filter the table data by. All elements are available
regardless of whether they are included as table columns.

Operator Select from the following operators: is equal to is not equal to is less
than is greater than is less than or equal to is greater than or equal to is
between is in top is in bottom

Value Enter the value or values appropriate for the operator selected. The
value can be either a text entry, or an element from the data.

3.8.3.4 Managing Filters

After you have added filters, use the Manage Filters feature to edit, delete, or change
the order that the filters are applied.

To manage filters:

1. Click the Manage Filters toolbar button to launch the Manage Filters dialog, as
shown in Figure 3-38.

Figure 3-38 The Manage Filters Dialog

Manage Filters %]

Filters for Current Selection:

1 'DEPARTMENT_NAME' is equal to 'SALES MANAGER' 7 a7 8
2 'SALARY' s in top '10°

OK Cancel

2. Hover the cursor over the filter to display the actions toolbar. Use the toolbar
buttons to edit the filter, move the filter up or down in the order of application,
delete, or add another filter.

3.8.3.5 About Conditional Formats

A conditional format changes the formatting of an element in the table based on a
condition. This feature is extremely useful for highlighting target ranges of values in
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the table. For example, you could create a set of conditional formats for the table that
display rows in different colors depending on threshold values.

3.8.3.6 Applying Conditional Formats to a Table

To apply a conditional format:

1. Click the Highlight button. This launches the Highlight dialog, as shown in
Figure 3-39.

Figure 3-39 The Highlight Dialog

Highlight

| Data Field
Operator

Value

Font Family
Size
Color

Background
Calor

Preview

Annual Salary -
is greater than v
& 100,000 L4
Tahoma ~ Bz |lU
10pt
Value 123
OK Cancel

2. Enter the fields to define a condition and format to apply, as described in
Table 3-5.

Table 3-5 Fields to Define Conditions and Formats

Field

Description

Data Field

Select the data field to apply the condition to. All elements are available
regardless of whether they are included as table columns. For example,
you may want to highlight in red all employees with salaries greater than
$10,000, but not actually include the salary element in the table.

Operator

Select from the following operators: is equal to is not equal to is less than
is greater than is less than or equal to is greater than or equal to is
between

Value

Enter the value or values appropriate for the operator selected. The value
can be either a text entry, or an element from the data.

Important: If entering a date value, use on of the following XSL date or
time formats: YYYY-MM-DD or YYYY-MM-DDTHH:MM:SS.

Font Family

Select the font to apply to the row of data that meets the condition. You
can also apply bold, italic, or underline emphasis.

Size

Select the size of the font to apply to the row of data that meets the
condition.

Color

Click the color box to open the Color Picker. Choose one of the
predefined colors or click Custom Color to define a color to apply to the
font.
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Table 3-5 (Cont.) Fields to Define Conditions and Formats

Field Description

Background Click the color box to open the Color Picker. Choose one of the

Color predefined colors or click Custom Color to define the background color to
apply to the row.

Figure 3-40 shows the table in the layout with the condition applied.

Figure 3-40 Example of Conditional Formatting

Home | Catalog | & New v B& Open~ | Signed In A:

"”-@ = “ :j @ | Insert | Page Layout I Table | _ Return
Select -RowstoDisplay | Filter |C0|_1diﬁonal Formatting | ~ Show |
b select - | |10 - F Filter BB Highlight o e
x Delete = ?Manage Filters @Manage Formats o o
50 10 1S 20 2 300 380 400 450 500 550 600
EX
Name Title Manager Department Annual Salary
Neena Kochhar Administration Vice | Steven King Executive 204,000.00
President
Lex De Haan Administration Vice | Steven King Executive 204,000.00
President

Alexander Hunold | Programmer Lex De Haan m 108,000.00

Bruce Ernst Programmer Alexander Hunold | IT 72,000.00

David Austin Programmer Alexander Hunmold | IT 57,600.00

Valli Pataballa Programmer Alexander Hunold | IT 57,600.00

Diana Lorentz Programmer Alexander Humold | IT 50,400.00

Nancy Greenberg | Finance Manager Neena Kochhar | Finance 144,000.00

Daniel Faviet Accountant Eﬁggxber Finance 108,000.00

g

John Chen Accountant Mancy Greenberg | Finance 98,400.00

3,628,800.00
!

3.8.3.7 Managing Formats

After you have added conditional formats, use the Manage Formats command to edit
or delete a format.

To manage formats:

1. Click the Manage Formats button to launch the Manage Conditional Formats
dialog, as shown in Figure 3—41.

Figure 3—-41 The Manage Conditional Formats Dialog

Manage Conditional Formats (%]

Conditional Formats for Current Selection:

2 'SALARY' is greater than '10,000" Value 123 S a v B

1 'DEPARTMENT NAME'is equal to TT'

OK Cancel

2. Hover the cursor over an item to display the actions toolbar. Use the toolbar
buttons to edit the format, move the format up or down in the order of
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application, delete, or add another format. The order of the conditions is important
because only the first condition that is met is applied.

3.8.3.8 Controlling the Display of the Total Row

By default, the layout editor inserts a total row in a table that sums numeric columns.
To remove the total row, click the Show menu and select the table view without the
highlighted total row. Figure 3-42 shows the Show menu options.

Figure 3—-42 The Show Menu Options

Show

= [

=

The total row can be further customized using the Total Cell tab and the Properties
pane. For more information see Section 3.8.6, "About the Total Cell Tab."

3.8.4 About the Table Column Header Tab
Figure 3-43 shows the Table Column Header tab.

Figure 3-43 The Table Column Header Tab

| Insert | Page Layout | Table Column Header I_

Select Font Alignment Grouping

Q Select - | Tahoma - 8pt -

Roodetre - (Bl 7 |UE & B

Mo Grouping =

totals

The Table Column Header tab enables you to perform the following:
= Edit the font properties of the table header column

= Edit the cell properties of the table header including border weight, style, and
color and background fill color

»  Set the vertical and horizontal alignment of the table header

= Apply grouping

3.8.4.1 About Grouping

"Grouping" groups together elements in the data of the same value. In a table,
applying grouping can make the table easier to read.

The Grouping option enables you to choose between "Group Left" or "Group Above".
Group left maintains the "group by" element within the table. Figure 3-44 shows a
table that has been grouped by Manager using Group Left.
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Figure 3-44 Example of a Table Grouped by Manager Using Group Left

Manager Employee Title Hire Date SALARY
Zlotkey Abel Sales Representative | May 10, 1996 11,000.00
Hutton Sales Representative | Mar 18, 1997 8,800.00
Taylor Sales Representative | Mar 23, 1998 8,600.00
Livingston Sales Representative | Apr 22, 1998 8,400.00
Johnson Sales Representative | Jan 03, 2000 6,200.00
Weiss Landry Stock Clerk Jan 13, 1999 2,400.00
Markle Stock Clerk Mar 07, 2000 2,200.00
Mikkilineni Stock Clerk Sep 27, 1998 2,700.00
Vollman Ladwig Shipping Clerk Jul 13, 1995 3,600.00
Stiles Shipping Clerk Oct 25, 1997 3,200.00
Sen Shipping Clerk Feb 11, 1998 2,700.00
Patel Stock Clerk Apr 05, 1998 2,500.00

Group above inserts a Repeating Section component, and extracts the grouping
element from the table. The grouping element is instead displayed above the table and
a separate table is displayed for each occurrence of the grouping element. Figure 3-45
shows a table that has been grouped by Manager using Group Above.

Figure 3—45 Example of a Table Grouped by Manager Using Group Above

Manager Zlotkey
Employee Title Hire Date SALARY
Abel Sales Representative May 10, 1995 11,000.00
Hutton Sales Representative Mar 18, 1997 8,800.00
Johnson Sales Representative Jan 03, 2000 6,200.00
Livingston Sales Representative Apr 22, 1993 8,400.00
Taylor Sales Representative Mar 23, 1998 8,600.00
Grand Total 43,000.00
Manager Wei
Employes Title Hire Date SALARY
Fleaur Shipping Clerk Feb 22, 1998 3,100.00
Geoni Shipping Clerk Feb 02, 2000 2,800.00
Landry Stock Clerk Jan 13, 1999 2,400.00
Markle Stock Clerk Mar 07, 2000 2,200.00
Mikkilineni Stock Clerk Sep 27, 1998 2,700.00
Mayer Stock Clerk Jul 15, 1997 3,200.00
Grand Total 22,100.00
Manager Vollman
Employes Title Hire Date SALARY
Bell Shipping Clerk Feb 03, 1996 4,000,00
Everett Shipping Clerk Mar 02, 1997 3,900.00

3.8.4.2 Example: Group Left

In Figure 3—46, the table data has been grouped by the elements of the first two
columns, Manager and Title. Notice that there is only one entry per manager name and
one entry for each job title under that manager name. This organizes the data rows

more cleanly in the table.
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Figure 3-46 Group Left Example

Employee Salary Report : Untitled Home | Catalog | [ Bs Open -~
EDataSuuroe =7 R 3% "EN ~ | Insert | Page Layout | Column |
EIB R Select Font Alignment | Data Formatting Grouping Formula
=[5 Employees
Name [ select - | Tahoma -lgpt - [|F1=|=|| Norne | Groupleft * | NoFormua - |
Elar::lr:::nn: 3 Delete - || B |7 |U & % | [ subtotals Running Total
Monthly Salary 50 100 150 200 250 300 350 400 450 500 550
AI,."."-‘Ialsalar"I TN T T T T T T T T T T T T T T T T T T N N T T T T T T T T T T T T T T T T T B}
Federal_Tax_Withheld
Title | Manager Title MName Department Annual Salary
Department Adam Fripp Stock Clerk Laura Bissot Shipping 39,600.00
DG Mozhe Atkinson Shipping 33,600.00
James Marlow Shipping 30,000.00
T1 Qlson Shipping 25,200.00
Alexander Hunold || Programmer Bruce Ernst ing 72,000.00
David Austin ing 57,600.00
Valli Pataballa I 57,600.00
Diana Lorentz m 50,400.00
Den Raphaely Purchasing Clerk | Alexander Khoo Purchasing 37,200.00
Shelli Baida Purchasing 34,800.00
| 3,628,800.00
[+l Components 1

3.8.4.3 Applying Subtotals

To further enhance a table, you can add a subtotal row to display for each grouped
occurrence of the element. Figure 3-47 shows the same table with the Subtotals box
checked. Notice that for each manager a subtotal row has been inserted.

Figure 3-47 Example of Subtotals

Employee Salary Report : Until Home | Catalog ‘ BS Open
E‘ Data Source ®H D | & E B | ~ | Insert | Page Layout | Column | O
EB Sl Select Font Alignment | Data Formatting Grouping Formula

=[5 Employees

Name [ select - | Tahoma et ||| ERl =] =]| None ~| \GroupLeft + | MoFormua -

Elar::lr:::nn: R Delete - ||B|Z|U & % | ﬁ{bmmls Running Total

e T T T . . P R -

FeS:?aI_‘T':;iWimheld | Manager Title Name Department Annual Salary

Title Adam Fripp Stock Clerk Laura Bissot Shipping 39,600.00

Department Mozhe Atkinson Shipping 33,600.00

Manager James Marlow Shipping 30,000.00

T2 Qlson Shipping 25,200.00

128,400.00

Alexander Huncld || Programmer Bruce Ernst ing 72,000.00

David Austin T 57,600.00

Valli Pataballa I 57,600.00

Diana Lorentz T 50,400.00

237,600.00

Den Raphaely Purchasing Clerk Alexander Khoo Purchasing 37,200.00

Shelli Baida Purchasing 34,800.00

Sigal Tobias Purchasing 33,600.00

O Guy Himuro Purchasing 31,200.00

Fropahs ) . | 166.800.00

3.8.4.4 Example: Group Above

In Figure 3-48, the table data has been grouped by Manager. Notice that in the design
pane, the Data Table component has been replaced with a Repeating Element

3-36 Report Designer's Guide for Oracle Business Intelligence Publisher



About Data Tables

component that contains the data table. The Manager element is inserted above the
table with a label.

Figure 3—-48 Group Above Example

Employee Salary Report : Untitled Home | Catalog | [ BS Open~ | SignedIn As ad
[zl Data Source = i
5 9 i 3& |:| = | Insert | Page Layout | Repeating Section
B [E= ROWSET -
£l [5 Employees Select Filter Sort
N.ame B select -~ W Fitter
First Name
Last Name R pelete - Manage Filters g
Monthly Salary .
Annual Salary ) 50 , oo 150 , 200 250 300 350 400 450 500 3
Federal_Tax_Withheld &
Title /
Department W Start Grouping - Manager
Manager Manager Manager
Title Name Department Annual Salary
Administration Vice Meena Kochhar Executive 204,000.00
President
Lex De Haan Executive 204,000.00
Programmer Alexander Hunold m 10&,000.00
Bruce Ernst T 72,000.00
David Austin m 57,600.00
valii Pataballa IT 57,600.00
Diana Lorentz I 50,400.00
Finance Manager Mancy Greenberg Finance 144,000,00
Accountant Daniel Faviet Finance 108,000.00
B3
Elobibh i 4 John Chen Finance 98,400,00
T3] M mardiim -

The label is a text item. Edit the text by double-clicking the item to select it, then
single-clicking to edit.

When you run the report, a separate table is created for each occurrence of the
grouping element. In Interactive output mode, the grouping element displayed at the
top of the table is displayed as a filter. Select the value that you want to view from the
list, as shown in Figure 3—49.

Figure 3-49 Grouping Element Displayed as a Filter

i Employee Salary Report Home | Catalog |
T r— e -
Employee by Manager
e

Manager | Adam Fripp hd

Title Name Department Annual Salary
v v v ~
Stock Clerk Laura Bissot Shipping 39,600.00
Mozhe Atkinsan Shipping 33,600.00
James Marlow Shipping 30,000.00
T10lson Shipping 25,200.00
Shipping Clerk Nandita Sarchand Shipping 50,400.00
Alexis Bull Shipping 49,200.00
Julia Delinger Shipping 40,800.00
Anthony Cabrio Shipping 36,000.00
304,800.00
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3.8.5 About the Column Tab

The Column tab is enabled when you select a specific column in a table. Figure 3-50
shows the Column tab.

Figure 3-50 The Column Tab

| Insert | Page Layout Column
Select Font Alignment | Data Formatting Grouping Formula Sort Conditional Formatting
k Select - | Tahoma - 8pt - |

None ~ | Mo Grouping = | Mo Formula < @ Highlight

Buswing Toks - 2~ Manage Formats

DTOtals Running lota

Rooeete - (|B|Z/UE & B

The Column tab allows you to perform the following actions:
= Edit the font properties of the column including style, size, and color

»  Edit the cell properties of the column including border weight, style, and color and
background fill color

= Set the vertical and horizontal alignment of the column contents

= Apply formatting to the column data (options depend on the data type)
= Apply grouping

= Apply a running total (or other formula) to the data

= Apply sorting and sort precedence

= Apply conditional formatting to the column

3.8.5.1 About the Data Formatting Options for Columns

The options available from the Data Formatting region of the tab depend on the data
type of the column selected. The tab provides common options to choose from. If an
option is not listed, you can enter a custom Oracle or Microsoft formatting mask in the
Properties pane. You can also set a formatting mask dynamically by including the
mask as an element in your data. These features are described in the following
sections:

= Section 3.8.5.2, "Applying Formatting to Numeric Data Columns"
= Section 3.8.5.3, "Applying Formatting to Date Type Data Columns"

= Section 3.8.5.4, "Custom and Dynamic Formatting Masks"

3.8.5.2 Applying Formatting to Numeric Data Columns

If the column contains numeric data, the following formatting options are available:

= Format - Select one of the common number formats from the list. The format is
applied immediately to the table column. The formats are categorized by Number,
Percent, and Currency, as shown in Figure 3-51.
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Figure 3-51 Number, Percent, and Currency Formats

Data Formatting

-1,234.57 ~
MNone {Unformatted)
-1-1,234.57 Q (Number) :
: -12% (Percent) l
(51,234.57) (Currency)
|-81,234.57

To apply a format not available from this list, see Section 3.8.8, "Applying Custom
Data Formatting."

s Decimal position - Click the Move Left or Move Right to increase or decrease the
decimal positions displayed.

= Show/Hide Grouping Separator - Click this button to hide the grouping separator
(for example, 1,234.00 displays as 1234.00). To show the grouping separator, click
the button again.

3.8.5.3 Applying Formatting to Date Type Data Columns

If the column contains dates, the following formatting options are available:

s Format - Select one of the common date formats from the list. The format is
applied immediately to the table column. The formats are categorized by Date and
Time, as shown in Figure 3-52.

Figure 3-52 Date and Time Formats

Data Formatting

None -

None {Unformatted)

| 5/18/10 %Dahe)
{May 18, 2010
|Tuesday, May 18, 2010

|5/18/10 11:57 PM (Time)
{May 13, 2010 11:57 PM
|Tuesday, May 18, 2010 11:57 PM

3.8.5.4 Custom and Dynamic Formatting Masks

You can apply any Microsoft or Oracle (recommended) format mask to a report data
field. You can manually enter the mask in the Formatting Mask property on the
Properties pane.

To enter a custom data formatting mask:

1. Select the data column or field in the layout.
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2. On the Properties pane, under the Data Formatting group select the Formatting
Style. Supported styles are Oracle and Microsoft.

3. In the Formatting Mask field, manually enter the format mask to apply.

For more information on Microsoft and Oracle format masks, see Section 4.15,
"Formatting Numbers, Dates, and Currencies."

Formatting masks can also be applied dynamically by either including the mask in a
data element of your report data, or as a parameter to the report. The mask is passed
to the layout editor based on the value of the data element.

To enter a dynamic formatting mask, in the Formatting Mask field, choose the data
element that defines the formatting mask. Figure 3-53 shows an example of setting a
dynamic number format mask. For this example, a parameter called NumberFormat
prompts the user to define a format mask when the report is submitted. The value is
passed to the Formatting Mask property and applied to the data field in the layout.

Figure 3-53 Dynamic Format Mask

[+ Data Source Ea ‘31 =| :.J g
[ Components | Inserk Page Layout Column |
=1 ki .
bopanes Return =S’ (i3
El Font elect Fant
Color — - o
Font Family Tshoma [ select - | Tahoma ~apt +|||F
Font Size Spk =
Rooete - [|B|Z2|UE & B |2
Font Style Mormal

Font wheight Marmal

Text Decaration  Mone

| Revenue
B Appearance
Background Color 1 12840 | 187480,13999999995
Border Bakkam - |36?63 354140, 1800000001
Border Left 35474 474729,43
Border Right
Q 47174 | 322740, 1699993999
Border Top Reverue
Padding Billed_Cuantity 25445 | 291264,97000000003
Discount_grmount
Text Alignment Target_Revenue 37275 | 314016.3300000001
Target_Quantit
Text Indent pm%uc‘tQNumbgr 34578 29301175
vertical Alignment | Praduct 37405 | 445455, 64000000013
width EE)DBduct_Type
29621 | 361443, 1400000001
[ Data Formattind  Brand
Farmatting Mask |{;Dm_D5;NUM'Ej, 25102 | 274049,6 1000000004
Formatting Style  Oracle 472831 | 4999999, 999909095

If you use a parameter to pass the format mask ensure that you select the Include
Parameter Tags option on the data model Properties page.

3.8.5.5 About the Formula Option

The options available from the Formula region of the column tab depend on the data
type of the column.

For more information about applying formulas, see Section 3.15, "Setting Predefined or
Custom Formulas."

3.8.5.6 About the Sort Option

To sort the data in a column, select the column, then under the Sort group click
Ascending Order or Descending Order.

To sort by more than one column, select the column, the sort order, and then assign a
Priority to each column. The priority list is a list of values beneath the sort order
commands.
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For example, in the employee salary table shown in Figure 3-54, assume you want to
sort ascending first by Title then sort descending by Annual Salary:

Figure 3-54 Employee Salary Table

Name Hire Date Title Annual Salary
Neena Kochhar 9/21/a9 Administration Vice President £204,000.00
Lex De Haan 1/13/93 Administration Vice President £204,000.00
Alexander Hunold 1/3/50 Programmer £108,000.00
Bruce Ernst 5/21f91 Programmer £72,000.00
David Austin 6/25/97 Programmer £57,600.00
alli Pataballa 2/5/98 Programmer £57,600.00
Diana Lorentz 2(7f39 Programmer £50,400,00
Nancy Greenberg a/17/94 Finance Manager £144,000.00
Daniel Faviet 8/16/94 Accountant £108,000.00
John Chen 9/28/97 Accountant £98,400.00

7,411,200.00

To apply the sort order to this table:
1. Select the Title column.
2. On the Column tab, under Sort, click the Ascending Order button.
3. From the Priority list, select 1.
Figure 3-55 shows the Priority list.

Figure 3-55 Priority List

4. Next select the Annual Salary column.

5. On the Column tab, under Sort, click the Descending Order button.
6. From the Priority list, select 2.

The sorted table is shown in Figure 3-56.
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Figure 3-56 Example of a Sorted Table

& =@ v | Insert | Page Layout | Column | __Return | L
ct Font Alignment | Data Formatting Grouping Formula Sort Conditional F
ct ~ | Tahoma et - [|F == | (5123457 ~|| NoGrouping = | NoFormua - O3 Wi | B Highlich
te - ||B 2| U JE & % L) E subtotals | [] Running Total 2~ | L& Manage
SIU L I1.UIUI » I1.5|UI » IZUIUI » IZSIUI IZUIU ) I3|50I » I4UIUI » I45|UI » ISUIUI » ISSIUI » |60|U| B IF.»SIU:'\gI ) II"UIUI )
MName Hire Date Title Annual Salary
Daniel Faviet 8/16/94 Accountant £108,000.00
John Chen 9/28/97 Accountant £98,400.00
Jose Manuel Urman 3/7/a8 Accountant £93,600.00
Ismael Scarra a/30/97 Accountant £92,400.00
Luis Popp 12{7/99 Accountant $32,800.00
Jennifer Whalen 9/17/87 Administration Assistant £52,300.00
MNeena Kochhar a/21/89 Administration Vice President £204,000.00
Lex De Haan 1/13/93 Administration Vice President £204,000.00
Nancy Greenberg a/17/94 Finance Manager £144,000.00
Michael Hartstein 2{17/96 Marketing Manager £156,000.00
| 7,411,200.00

3.8.5.7 Removing a Sort Order

To remove a sort order applied to a column:

1. Select the column.

2. From the Sort region on the Column tab, click the appropriate button of the sort
order that has been applied. For example, to deselect the ascending order, click the

Ascending Order button to undo the sort.

3.8.6 About the Total Cell Tab

The Layout Editor automatically inserts a grand total row when you insert a data table
to the layout. As shown in the section on grouping, you can also insert subtotal rows
within the table based on a grouping element. To edit the attributes of the cells in a
grand total or subtotal row, select the cell and use the options in the Total Cell tab

shown in Figure 3-57.

Figure 3-57 The Total Cell Tab

| Insert | Fage Layout Total Cell
Select Font Alignment | Data Formatting Formula Conditional Formatting
[% select - | Tahoma ~gt <[ Fl=l=]|-L234.57 ~|| summation - i3
Roere - [[B|lZ2|UE & B = = LA Running Total

The Total Cell tab enables you to perform the following;:

»  Edit the font properties of the total cell

= Edit the cell properties of the total cell including border weight, style, and color

and background fill color

»  Set the vertical and horizontal alignment of the table header

= Apply formatting to the cell data
= Apply a formula to the cell
= Apply conditional formatting to the cell
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3.8.6.1 Applying Data Formatti
See Section 3.8.5.1, "About the D

3.8.6.2 Applying a Formula

ng to a Total Cell

ata Formatting Options for Columns."

By default, the formula applied to a Total Cell within a numeric column is a sum of the

column items. The Formula opti

on enables you to apply a different formula.

Not all options available from the Formula region of the column tab are applicable to a

Total Cell.

For more information about app
Custom Formulas."

3.8.7 Inserting Dynamic Hyperlinks

lying formulas, see Section 3.15, "Setting Predefined or

The layout editor supports dynamic hyperlinks in tables.

To insert a dynamic hyperlink:
1. Select the table column.

2.
Figure 3-58.

Click Properties. The column properties include an option for URL, as shown in

Figure 3-58 URL Property Option for the Selected Column

to the element that provides
{}. For example:

i+ Data Source @ ®$ EE E ~ | Insert I Page Layout Column

R Select Font Alignment | Data Formatting|  Grouping

= Properties —

B Font [ select - | Tahoma ~ 8ot (== ]=]| None *|| No Grouping | | NoF
Color I Roete - IBIZIUE & B ||= = otals i
Font Famil Tahoma

v 50 100 150 200 250 300 350 400 450 50
FDﬂkSlZE ml PRI [T T T T T [ TR T T T T N TR N T S N N R S ) il I T T . |
Font Style Normal | Manager | Full Name Tit
Font Weight Normal Steven King Matthew Weiss Stc
Text Decoration  None Adam Fripp Stc
B Appearance Payam Kaufling Ste
Color L |
WB::M ° Shanta Vollman Ste
Border Left o Kevin Mourgos Stc
i Select the column
Border Right e Cambr;
Rioh o and then select the (E2C 2t |
pB“'dE' Top oo o o ~4—— Properties pane Eleni Ziotkey sal
John Russell sal
Text Aignment  Left
Text Indent Opx Karen Portners sal
Vertical Alignment Top Alberto Errazuriz sal
Viidth 256 | |

Bl pata Formatting
Formatting Mask End Grouping - Department
Formatting Style  Microsoft

B Misc
URL

Pa

In the URL field, enter the static portion of the URL and embed the absolute path

the dynamic portion of the URL within curly braces

http://example.com/show_page?id={/DATA/GROUP1/ELEMENT_ NAME}

where http://example.com/show_page?ids= is the static portion of the URL
and {/DATA/GROUP1/ELEMENT_NAME} is the absolute path to the element in the
data that supplies the dynamic portion.
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For example, in the employee salary report, suppose each employee name should
render as a hyperlink to the employee's person record. Assume the static portion of the
URL to each person record is

https://people.hrserver.com/records/show_page?id=

The dynamic portion comes from the data element EMPLOYEE_ID. For this example,
append the full path to the EMPLOYEE_ID element within curly braces and enter this
in the URL field as follows:

https://people.hrserver.com/records/show_
page?id={/ROWSET/ROW/EMPLOYEE_ID}

If you are unsure of the correct element names in the absolute path, hover your mouse
over the data element on the Data Source pane to display the path in the hover text, as
shown in Figure 3-59.

Figure 3-59 Hover Text Displaying Absolute Path to Element

Salary Report : Manager Summary —

= Data Source E@ ] “i ]
E- [£5 ROWSET

B [ Employees
Full Name 52| Layout Grid
First Name
Last Name 3 Repeating Set
Monthly Salary @
Annual Salary B
Federal Tax Withheld
Title
Department
Employeg, ID
Manage@

| /ROWSET/ROVI/EMPLOYEE_ID

3.8.8 Applying Custom Data Formatting

BI Publisher supports the use of the Oracle and Microsoft format masks for custom
data formatting. The results of the output depends on the selected locale.

For more information on Microsoft format masks, see Section 4.15.4, "Using the
Microsoft Number Format Mask."

For more information on Oracle format masks, see Section 4.15.6, "Using the Oracle
Format Mask."

To apply custom data formatting:
1. Select a data field or column.

2. Click Properties. The Data Formatting options are displayed as shown in
Figure 3-60.
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Figure 3-60 Data Formatting Properties

[ Data Source B ¥ EBE v | Insert: I Page Lavout
[ Components Select Font Alignment | Data Fc
= Properties —
B Font [¥ select - | Tahoma Tapt || T I=1= || Custor
Calor — Rooete - [B|Z[UE & B |
Fant Family Tahoma
o 100 150 200 250 300 350
Font Size Spt | T T T T T T [N T N T T [N T T T T T T T S T | IR S T T T B |
East 200-10
Font Style Mormal
Font Weight TMormal Bast 200-20
Text Decoration  Mone East 200-30
El Appearance East 200-40
Eackground Color ]
Border Battom @ G_B: Gen2 Year Totals by Product, Measures on Rows
Border Left =]
Border Right = Quarker Product Total
Border Tap — @ Qirl 95,520.00
Paddirn 4px 4px 4px 4px ©
d PSP P Otz 101,679.00
Text Alignment  Right
Text Indent O Qb3 105,215.00
Wertical Alignment Top Qtrd 95,141.00
Widkh 1690 Qkrl 42,877.00
H Dpata Formatting atr2 45,362.00
Formatting Mask 25999099
Qb3 47,343.00
Formatting Style  Oracle
El Misc Qkrd 43,754.00
LRL Qkrl 52,943.00
bz 56,317.00

3. From the Formatting Style drop-down list, select the Oracle or Microsoft
formatting style. The Oracle formatting style is recommended.

4. In the Formatting Mask field, enter a formatting mask. For example, for a column
that contains product totals, you can use the Oracle formatting style, and the
9G999D99 formatting mask to display total values with two zeros to the right of
the decimal place.

3.9 About Charts

The layout editor supports a variety of chart types and styles to graphically present
data in the layout. Figure 3—61 shows side-by-side vertical bar and pie charts in the
layout editor.

Figure 3-61 Side-by-Side Vertical Bar and Pie Charts in the Layout Editor

{,Dmeswe BHE 9 AT & E S [T [ e | e | Qs
e Rorvset Seket Chat Tyes Chast Sires E Flter Coewrt
(SR E
[ sradiert. | Trive BBt Take

Fencatony By et - [

i s [ il B [
Prokatstre L N T N L
Praudshesed = . . 8 il
B Pevernse
B Prewevee Drop Yolue Here [Chart Tike) Dvop Series Here
Bl L
59
49 ms 1
ms 5 2
Dsenes 3
@senes 4
Wsenes 5
m
4 i
— + e imene TR
TFrapertes =

Once inserted, you can edit the chart properties using the dynamic toolbars or the
Properties pane. The Properties pane extends the options from the Chart tab and
enables you to enter very specific custom settings for the following:

s Chart Effect
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s Chart Legend

n  Chart Plot Area
n  Chart Title

n  Chart Label

Note: The following Chart Label properties apply to Scatter and
Bubble chart types only: Title Font, Title Horizontal Align, Title Text,
and Title Visible.

m  Chart Values

Note: Some font effects such as underline, italic, and bold might not
render in PDF output.

3.9.1 Inserting a Chart

To insert a chart:
1. From the Insert menu, select and drag the Chart component to the layout.

By default an empty vertical bar chart is inserted and the Chart dynamic tab is
displayed, as shown in Figure 3-62.

Figure 3-62 Chart Dynamic Tab

t—a x :._l A | Insert | Page Layout | Chart |

Select Chart Types Chart Styles Effect

Filter Convert

0y Select - M = ¥ Filter A Pivot Table
I I _ 3D Effect

* pelete - I I | Manage Filters | Switch Series and Dimensions
201

SIU lUIU 1.?0

|U ZSIU 3UIU 3|50 400 450 500 550 00

“Salaries by Departme

I
Drop Value Here Crop Series Here

Drop Label Here

2. To change the chart type, click the Chart Type list to select a different type. In
Figure 3-63 the chart type is changed to Pie.
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Figure 3-63 The Pie Chart Type

@ 2 “ :J " | Insert | Page Layout | Chart |

Select Chart Types Chart Styles Effect Filter Convert
Db select - v - W Fiter [ pivot Table
ol =
® pelete - I I Manage Filters Switch Series and Dimension:
s h Area > 200 250 300 250 400 450 500 550 600
b Bar > Salaries by Departm
|3a Bubble >
e Line >
& rie >
@ Circular = 0 0 ll:-/Y
3
{4l 3D Graphs > 0 .
Drop Value Here Fie v\[b Pie-Bar Multiple Fies Ring
Ring Bar Multiple Rings
||

3. Select and drag the data fields from the Data Source pane to the appropriate areas
in the chart. The chart immediately updates with the preview data, as shown in
Figure 3-64.

Figure 3-64 Dragging and Dropping Data Fields to a Chart

“Sales by Region N =

I Data Source 7 IR ) & ~ | Insert | Page Layout | Chart |
EIB DATA_DS Select Chart Types Chart Styles Effect Filter Converl
B3 6.1
- [ag] PROD_DSC I3 select - - - 7 Fiter A pivot Table
- [abe] BRAND il I P D Effect .
[ag) BILL DT *® oelete - I I Manage Fiters | [5] Switch Series ani
[ ORDER DT : 50 100 150 200 250 300 350 400 450 500 550
""PROD_KEY ..... PO T N T T T T T T T T T AT S T S T T T T T T T A T T N T T R SN T ST AN}
-.[13] DOLLARS
UNITS
- (193] PROFIT =
- [abe] REGION
.[sbe) DISTRICT e ——
DOLLARS EBRAMND
Drop Value Here Crop Series Here
19.69%
M Swordsman
9.451% @ Electrosmooth
M Spring Breeze
W Coddess
60.06%
10.80%
Drop Label Here
[+ Components

4. To resize the chart, drag and drop the resize handler on the lower right corner of
the chart, as shown in Figure 3-65.

To preserve the aspect ratio when resizing a chart, press and hold the Shift key
before starting to drag the corner.
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Figure 3-65 Chart Resizing

IVIALLTIEVW WWEIS S
B Adam Fripp
W Payam Kaufling
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John Russell
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M Eleni Zlotkey

3.9.1.1 About the Chart Tab
The Chart tab enables you to perform the following:

»  Select a different Chart Type

= Apply a different Chart Style

= Enable 3-D effects

»  Filter the data that is displayed in the chart
= Manage multiple filters

»  Convert the chart to a pivot table or switch the series and dimensions values

3.9.1.2 Applying and Managing Filters

See Section 3.8.3.2, "About Filters" for information on how to apply and manage filters.

3.9.1.3 Converting a Chart to a Pivot Table

To convert a chart to a pivot table:
1. Select the chart.
2. Inthe Convert group, click Pivot Table.

The layout editor converts the label, series, and value elements of the chart into the
appropriate rows, columns, and data elements of a pivot table.

3.9.2 Changing the Formula Applied to a Chart Measure Field

By default, the chart displays a sum of the values of the chart measure. You can
change the formula applied to a chart measure field by selecting an option from the
Chart Measure Field tab.

To change the formula:

1. Select the measure field in the chart. This displays the Chart Measure Field tab, as
shown in Figure 3-66.
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Figure 3-66 Chart Measure Field Tab

e e G

2.

Emhﬂume B 2|8 EE v | Insert | Page Layout | Chart Measure Field
EB DATA_DS Select Formula
BB 6.1
- [sb] PROD_DSC b Select - | Summation - @
BRAMND
- [abg] BILL_DT & pelete - | [ Running Total
~-[sbg] ORDER_DT 50 100 150 200 250 300 350 400 450 500
[ PROD_KEY T T S | | S | T | T
-[193 DOLLARS
UNITS
- [199 PROFIT
- [abe] REGION
- [abe] DISTRICT
. DOLLARS BRAND
Drop Value Her Drop Series Here
T9.60%
M swordsman
9.451% @ Electrosmooth
M Spring Breeze
W Coddess
60.06%
10.80%
Select from the following options available from the Formula list:
» Count
=  Sum

= Running Total

3.9.3 Sorting a Chart Field

To sort a field in the chart:

1.
2.
3.

Select the field to display the Chart Field tab.
On the Chart Field tab select Sort Ascending or Sort Descending.

To sort by multiple fields, apply a Priority to each sort field to apply the sort in the
desired order.

3.9.4 Using Advanced Chart Features

The following features enable you to apply additional formatting to your charts:

Section 3.9.4.1, "Time Series Axis Formatting"
Section 3.9.4.2, "Hide Axis Option"

Section 3.9.4.3, "Independent Axis Formatting"
Section 3.9.4.4, "Axis Scaling"

Section 3.9.4.5, "Pie Slice Formatting"

If you do not select a value for these format options above, the BI Publisher default
system settings are applied.
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3.9.4.1 Time Series Axis Formatting

When the x-axis of your line chart is a date field, BI Publisher applies a time series
format based on the range of the data as shown in Figure 3-67. You can customize the
display of the time series in your chart, or turn it off.

Figure 3—67 Time Series Date Formatting Options

Data Source
Components

=/ Properties

Appearance

Chart

Chart Effect

Chart Legend

Chart Plot Area

Chart Title

Chart Label

Chart ¥alue {1)

Chart ¥Yalue {2)

Time Series

Day Format [:% Day of Week Mumber
Month Format  Month Long

Time Format

Tirme Seties True

Year Format “ear Short
Misc

To select time series date formatting options for a chart:
1. Expand the Time Series report properties category.
2. In Day Format field, select one of the following format options for days:
= None to hide the day label.
= Day of Week to display only the names of each day of the week.
= Day Single Letter to display only the first letter of each day of the week.

= Day of Week Number to display only the number assigned to each day of the
week. For example, if Sunday is the first day of the week, it can be displayed
as 1, Monday displayed as 2, etc.

= Day of Month to display all days in a month by the actual date. For example,
the first day of the month would be displayed as 1.

3. In Month Format field, select one of the following format options for months:
= None to hide all month labels.

= Month Number to display only a number for each month in the year. For
example, if the first month of the year is January, it is displayed in the chart as
1.

= Month Single Letter to display only the first letter of each month in the year.

= Month Short to display only the short names for each month. For example,
January can be displayed as Jan.

= Month Long to display only the full name of each month.

4. In the Time Format field, select one of the following format options for time
increments:

s None to hide all time labels.
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= Hour to display time in hours.
= Hour24 to display time in 24 hour increments.
= Hour24 Minute to display minutes in 24 hour increments.
= Hour Minute to display time in hours and minutes.
= Second to display time in seconds.
5. In Year Format field, select one of the following format options for years:
= None to hide all year labels.
= Year Short to display only the short names for each year.

= Year Long to display only the full name of each year.

3.9.4.2 Hide Axis Option

You can hide axis labels in reports for certain situations such as when you are working
with small charts or visualizing data without values. This option is especially useful
for creating reports that evaluate trends.

To hide an axis:

1. On the Properties pane, expand the Chart Label, Chart Value (1) or Chart Value
(2) report properties category.

2. In Axis Visible, select False.

3.9.4.3 Independent Axis Formatting

You can format decimal digits and numbers for each Y axis in a multiple Y-axis report.
To format decimal digits and number types for an axis:

1. On the Properties pane, expand the Chart Value (1) or Chart Value (2) report
category.

2. To format axis decimals, in the Axis Decimals field, enter the number of decimals
to display for a data element per axis.

3. To format data decimals for an axis where the Data Visible property is set to True,
enter the number of decimals to display on the axis.

4. To apply number formatting to an axis, in the Format field, select one of the
following options: General, Percent, or Currency.

5. If you select Currency, in the Currency Symbol field, manually enter the currency
symbol.

3.9.4.4 Axis Scaling

You can set chart axis scaling as logarithmic or linear in reports.
To format axis scaling:

1. On the Properties pane, expand the Chart Value (1) or Chart Value (2) report
properties category.

2. In the Axis Scaling field, select one of the following options: Logarithmic or
Linear.
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3.9.4.5 Pie Slice Formatting

You can format pie slice charts to display percentages, total actual values, percentages,
and labels.

To format pie slices:
1. On the Properties pane, expand the Plot Area report property category.

2. In the Pie Slice Format field, select one of the following options: Percent, Value,
Label, or Label and Percent.

3.10 About Gauge Charts

A gauge chart is a useful way to illustrate progress or goals. For example, Figure 3-68
shows a report with three gauges to indicate the status of regional sales goals:

Figure 3-68 Gauges Showing the Status of Regional Sales Goals

Regional Sales

Sauth Web Direct East

Iy
® v v @ 300K 400K

1028 15.3M
B 15 200K 500K
/ 5 1M 20,41
M 18M 100K 00K
0 21M 0 700K

0 25.5M

DOLLARS 10.6M DOLLARS 487K DOLLARS 13.8M

Southern Region Goal: Web Direct Region Goal: Eastern Region Goal:
%15,000,000 $400,000 $18,000,000

3.10.1 Inserting a Gauge Chart

To insert a gauge chart in the layout:

1. From the Insert menu, select and drag the Gauge component to the layout. This
inserts an empty gauge chart, as shown in Figure 3-69.
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Figure 3-69 An Empty Gauge Chart
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2. Select and drag the data fields from the Data Source pane to the Label, Value, and
Series areas of the chart. The chart immediately updates with the preview data.

Figure 3-70 shows REGION being dragged to the Label area and DOLLARS being
dragged to the Value area:

Figure 3-70 Dragging and Dropping REGION and DOLLARS to a Chart
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Note the following:

= A separate gauge is created for each occurrence of the Label (that is, each
REGION). One set of properties applies to each occurrence.

= By default, the Value field is a sum. You can change the expression applied to
the value field. See Section 3.9.2, "Changing the Formula Applied to a Chart

Measure Field."

= You can apply a sort to the other gauge chart fields.

3.10.2 Setting the Properties for a Gauge Chart

Use the Properties Pane to set detailed options for a gauge chart.

3.10.3 Applying and Managing Filters

See Section 3.8.3.2, "About Filters" for information on how to apply and manage filters.

3.11 About Pivot Tables

The pivot table provides views of multidimensional data in tabular form. It supports
multiple measures and dimensions and subtotals at all levels. Figure 3-71 shows a

pivot table.

Figure 3-71 A Pivot Table

Q ———————— Subtotal Total
Magicalor
FrevRevenue Revenue PrevRtevenue Revenue Previtevenue Revenue
AOHICAE0 DISTRICT 5,537.00 3,741.00 5,507.00 3,741.00 5,567.00 3,741.00
CINCINNATI ISTRICT 9,875.00 38,054.00 9,875.00 38,054.00 9,875.00 38,0549.00
DETROIT DISTRICT 5,706.00 2,149.00 5,706.00 Z,149.00 5,706.00 Z,149.00
CENTRAL REGICN 1 1 1
KANSAS CITY DISTRICT 9,467.00 53,319.00 9,267.00 55,519.00 9,467.00 55,519.00
MINNEAPOLIS
140.00 231,00 140,00 31.00 190,00 3100
DISTRICT
Subtotal 30,775.00 93,654,00 30,7750 59,694,000 30,775.00 59,694.00
Total 30,775.00 93,654.00 30,775.00 89,604.00 30,775.00 59,694.00

3.11.1 Inserting a Pivot Table
To insert a pivot table:

1. From the Insert tab, select and drag the Pivot Table component to the layout.
Figure 3-72 shows the empty pivot table structure.
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Figure 3-72 The Empty Pivot Table Structure
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Drag and drop data fields from the Data Source pane to the row, column, and data
positions.

Drag multiple fields to the pivot table and place them precisely to structure the
pivot table, as shown in Figure 3-73.

Figure 3-73 Dragging and Dropping Data Fields to a Pivot Table

- [399) Periods. year
. (193] Measures. dollars

[l Data Source
Bl [ Rowset
23 Row
. [abg] Products.type
- [abe} Products.brand

Markets.region
—

Do RED B [ Insert ] Page Layout I Pivot Table |

Select Filter Row Grand Total | Row Subtotal | Column Grand Total | Column Subtotal
h Select - ?Filher T 1113, T T T 1T I - - M
=
¥ Delete - Manage Fiters | | — H tﬁ'j i
I O U - DO O . DU O .
e
g
-
E= 2
~ s |2000 1998 1999 Total
CENTRAL REGIO ... 1,555,548.00 4,006,702.00 4,431,632.00 9
EASTERN 1,701,664.00 21,644, 266.00 109,795,216.00 133
SOUTHERN REGION 11,788,042.00 36,271,646.00 43
WESTERN REGION 5,389,374.00 24,907,200.00 30
Total 8,646,586.00 37,439,010.00 175,405,694.00 221

By default the pivot table is inserted with no data formatting applied. To apply a
format to the data, click the first column of data to enable the Pivot Table Data
toolbar. On the Data Formatting group, select the appropriate format as shown in
Figure 3-74.
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Figure 3-74 Selecting a Format
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DISTRICT
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DISTRICT
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CHARLOTTE DISTRICT 2935980 4. 7658 76ED 5.059862E6

4. Optionally resize the pivot table by clicking and dragging the handler in the lower
right corner of the pivot table, as shown in Figure 3-75.

Figure 3-75 Resizing a Pivot Table
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| | | | | | |
# pelete - i Manage Filters i I ! i : Switch Rows and Columns :
] 00 150 II 200 2% 300 350 400 450 500 550 600 650 700 750
1998 1999 2000 Total
“+ CENTRAL REGION 4,008,702.00 4,431,632.00 1,555,548.00 9,993,382.00
CHICAGO DISTRICT 1,555,548.00 1,555,548.00
KANSAS CITY DISTRICT 4,008,702.00 1,897,554.00 5,904,256.00
MINNEAPOLIS 2,534,078.00 2,534,078.00
DISTRICT
EASTERN REGION 21,544,266.00 109,795,216.00 1,701,664.00 133,141,146.00
NEW YORK DISTRICT 23,591,754.00 1,409,228.00 25,100,982.00
YOUNGSTOWN 7,798,224.00 292,435.00 3,090,560.00
DISTRICT
BOSTOM DISTRICT 4,375,500,00 43,366,894.00 47,742,494,00
PHILADELPHIA 9,470,442.00 42,736,568.00 52,207,010.00
DISTRICT
SOUTHERN REGION 11,788,042.00 36,271,546.00 48,059,588.00
MEMPHIS DISTRICT 4,523,472.00 4,523,472.00
ATLANTA DISTRICT 5,231,612.00 5,231,612.00
CHARLOTTE DISTRICT 293,985.00 4,765,876.00 5,059,862.00

3.11.2 Customizing a Pivot Table Menu

After you insert a pivot table customize the appearance and layout using the following
dynamic tabs:

Pivot Table tab
Pivot Table Header tab
Pivot Table Data tab
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3.11.3 About the Pivot Table Tab
Figure 3-76 shows the Pivot Table tab.

Figure 3-76 The Pivot Table Tab

'1@ g “ :.J = | Insert | Page Layout | Pivot Table |
Select Filter Row Grand Total | Row Subtotal | Column Grand Total | Column Subtotal Convert

D select + | W Fitter o i g _l—H T I M | [l convert to Chart
K pelet= - Manage Filters | | — Switch Rows and Columns

3.11.3.1 Applying Filters

See Section 3.8.3.2, "About Filters" for a description of he Filter and Manage Filters
features.

3.11.3.2 Customizing the Display of Totals

The Pivot Table tab enables you to quickly customize the display of grand total and
subtotal rows.

By default, the layout editor inserts the pivot table with the total and subtotal displays
as shown in the tab:

= Row Grand Total - Inserted at bottom of table

= Row Subtotal - Inserted at top of each subgroup, with no row header

= Column Grand Total - Inserted at the far right

s Column Subtotal - Inserted to the left of each column subgroup, with no header

Change the positioning and display of totals and subtotals by clicking the appropriate
group in the tab and selecting the desired layout pattern from the menu.

3.11.3.3 Converting a Pivot Table to a Chart

The Convert Pivot Table to a Chart command converts the pivot table to a default
vertical bar chart. After conversion, customize the table as described in Section 3.9,
"About Charts."

Figure 3-77 shows the pivot table created in the preceding step converted to a vertical
bar chart.
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Figure 3-77 A Pivot Table Converted to a Vertical Bar Chart
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3.11.3.4 Switching Rows and Columns

Use the Switch Rows and Columns command to see a different view of the same data.
Figure 3-78 shows the pivot table created in the previous step with rows and columns
switched.

Figure 3-78 A Pivot Table with Rows and Columns Switched

E@ a |“I:C| | " | Insert | Page Layout | Pivot Table |

Select Filter Row Grand Total | Row Subtotal | Column Grand Total | Column Subtotal Convert
B select - | W Filter o i [ e Rl I M t'iilj' [ convert to Chart
|
K pelete - Manage Filters | | n— [ {31 switch Rows and Columns
50 100 150 200 250 300 350 400 450 500 550 600 650 700 750
CENTRAL REGIOMN EASTERM REGION
CHICAGO DISTRICT | KANSAS CITY MINMEAPOLIS MEV
DISTRICT DISTRICT DIS
2000 1,555,548,00 1,555,548,00 1,701,664.00
1998 4,008,702.00 4,006,702.00 21,644,266.00
1999 4,431,632,00 1,897,554,00 2,534,078,00 109,795,216,00
Total 9,993,382.00 1,555,548.00 5,904,256.00 2,534,078.00 133,141, 146.00

3.11.4 Customizing the Pivot Table Headers
The Pivot Table Header tab is shown in Figure 3-79.

Figure 3-79 The Pivot Table Header Tab

@ i | 3% HJ ﬁj | v | Insert | Page Layout | Pivot Table Header L

Select Font Alignment Sort Data Formatting
% select - | Tahoma -lapt C||[ T == None -

Rocee - [[BlZ|UIE & B ||
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Select the column or row header of the pivot table and use the Pivot Table Header tab
to perform the following:

s Customize the fonts, colors, alignment and other display features of the header

= Apply a sort order (for more information see Section 3.8.5.6, "About the Sort
Option")

= Apply data formatting (if the data type is number or date)

3.11.5 Customizing the Pivot Table Data
The Pivot Table Data tab is shown in Figure 3-80.

Figure 3-80 The Pivot Table Data Tab

'19 B)a = :J @ | Insert | Page Layout | Pivot Table Data

Select Font Alignment | Conditional Formatting | Data Formatting Formula
% select ~ | Tahoma ~ &pt T Highlight -1,234.57 = | Summation - @
RKoeee - (|[B|Z2|U|EA & B ||=|=|5]| 02 Manace Formats s &2 o Running Tota

Select the data area of the pivot table and use the Pivot Table Data tab to perform the
following actions. The comman